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General

& Main contents

1.1 About the document
The document relates to Store Flex Release 1.7.

This document describes the design of the architecture
variant Store Flex, which is an advanced lighting control
solution for retail applications. It is the most complete
lighting solution in the market, capable of handling
small optimized solutions up to highly advanced
installations covering multiple areas, zones, presets and
schedules.

1.2 Intended audience

The information in this guide is specifically intended for
System Centers, installers, site engineers, and customer
IT departments.

The instructions are placed in logical chapters and in
chronological order. When following the procedures,
you must be able to design, install and commission a
functioning lighting system.

& Chapter contents

1.3 Related documents
Refer to other documents for more information:

Mini Kit 1.2

* Quick start guide
describes the installation, commissioning,
configuration, and usage of the lighting system.

Kit 2.3 (with gateway or touchscreen)

e Quick start guide
describes the installation, commissioning, and
configuration of the lighting system.

e User guide for Store Control Ul
describes the usage and configuration of the user
interface of the lighting system.

Flex 1.7

e System guide
describes the system design and how this design can
support the requirements of a customer.

e User guide for Store Control Ul
describes the usage and configuration of the user
interface of the lighting system.
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1.4 Abbreviations

The following abbreviations are used throughout the
document:

Abbreviation Explanation Abbreviation Explanation
BLA Base Link Area PWM Pulse-Width Modulation phase cut dimming
BMS Building Management System STP Shielded Twisted Pair
BoM Bill of Materials ul User interface
DALI Digital Addressable Lighting Interface BSR Business Support Request
communication protocol
C4cCs Ticketing system capturing customer tickets
DMX Digital MultipleXed communication protocol
C-ROC Signify Customer Remote Operating Center
DSI Digital Serial Interface communication protocol
C-SAT Customer Satisfaction
HVAC Heating, ventilation, and air conditioning
csl Certified System Integrator
IR Infrared
GSO Global Software Operations
PDDEG-S Philips Dynalite DIN-rail Ethernet Gateway - ) - - )
Supervisor (in short: Ethernet Gateway Supervisor) OTRS Ticketing system capturing corporate tickets
PDEB Philips Dynalite Ethernet Bridge SAP Enterprise software for customer management

(in short: Ethernet Bridge)

PDEG Philips Dynalite Ethernet Gateway
(in short: Ethernet Gateway)

PE Photo electric

PIR Passive Infrared

< Main contents & Chapter contents
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1.5 Terms and definitions

The following terms and definitions are used
throughout the document:

Term Definition

Format A group of sites with similar design or style (In retail
also known as the formula). Every site belongs to
only one format (e.g., supermarket, convenience
store).

Area A lighting control area (for example Sales floor or
Back of house)

Scene A specificset of light levels that can be edited and
recalled, sometimes also referred to as Preset.

Logical channel A lighting control sub-zone included inside an area
(like Bakery spots or Bakery counter)

Schedules Set of all scheduled events (simple events, special
events, holidays) that automatically control the
lighting of the sites in a specific format

Store Control Ul User interface of the system used on a tablet or
touchscreen (in short: Ul)
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System description

2.1 System architecture

The Store Flex system is an onsite lighting system that is
tailored to the needs of the customer. It can be applied
in all store formats but is specifically aimed at the
supermarket and hypermarket segment.

The system is based on Dynalite components that allows
for wired, wireless or hybrid control control solutions
like DALI, Zigbee, 0-10V or relay switching to bring the
highest level of lighting control to a store.

2.1.1 Benefits

While being targeted at retailers that value one or more

of the principles of the system, expected key benefits are:

e Maximize energy savings by easy scene and schedule
management

e Improve in-store ambiance

e Easy to use user interface for controls and
configuration of the system

e Easyinstallation and maintenance

e Future proof and upgradable

Upgrade scenario

Upgrade existing sites to grow the system with the
store, expanding on features and insights without
compromises on usability.

It is also possible to connect different sites to the cloud
and start using Multisite System Manager, centrally
managing and monitoring the lighting at all sites,
making sure that all have the same look and feel.
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2.1.2 Architecture

All architectures operate onsite with a wired
architecture, consisting of Philips Dynalite lighting
control components.

Gateway

The Ethernet Gateway (PDDEG-S) functions as the
‘central store controller’, interconnecting the onsite
hardware. The device:

Provides access to the Store Control Ul that enables
scenes and schedules management;

A connected Wireless Access Point enables the Store
Control Ul to be accessible via a mobile device;
Offers a fully futureproof system that is ready to
upgrade to Multisite, where the PDDEG-S will act as
Site Gateway, safeguarding secure cloud connection.
Tailored to the needs of the customer.

Supports BACnet, integrating with Building
Management Systems (BMS).

Note
The router and the mobile device (tablet) are not part
of the Signify delivery.
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PDEG Ethernet Gateway or PDTS Touchscreen
Alternatively, the PDEG and PDTS can also be used as central
store controllers.

The devices include similar features as the PDDEG-S,
providing access to the Store Control Ul that enables
scenes and schedules management.

Note
* Only one device can act as the central store controller.
e |tis possible to combine a PDTS with a PDDEG-S
(for example when using wireless controls), but the
Store Control Ul can only be used on one device.

A DDNP1501 Network power supply is required.

The PDEG Ethernet Gateway can connect to a Wireless
Access Point to enable the Store Control Ul to be
accessible via a mobile device.

The PDTS Touch Screen offers a local wall mounted user
interface for the Store Control Ul.

When using a PDTS touchscreen in combination with a
PDDEG-S or PDEG Ethernet Gateway, the PDTS can then
only be used as a scene controller. In this specific case,
configuration of schedules is not possible.

Upgrade to Multisite is not possible without installation
of a PDDEG-S that requires complete recommissioning of
the system.
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2.1.3 Wireless architecture
The wireless architecture is an extension to the wired
architecture of Store Flex.

As in wired Store Flex, the PDDEG-S functions as the
‘central store controller’. A PDDEG-S Ethernet Gateway:

Connects up to 25 PDZG-E Wireless Gateways to the
system by using its Ethernet connectivity capabilities.
Ensures the secure connection between the PDZG-E
Wireless Gateways and the rest of the DyNet network

The PDZG-E Wireless Gateway:

Links the wireless Zigbee network over Ethernet to
the wired DyNet network;

Connects up to 60 wireless nodes (luminaires and/or
transceivers) via Zigbee

Note
The router and the mobile device (tablet) are not part
of the Signify delivery.
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Store Flex wireless supports easy commissioning with
the Philips Dynalite Enabler app, using the Bluetooth
functionality of each luminaire and/or node.

=) Note
As an alternative, also the PDTS Touchscreen can be
used as ‘central store controller’. However, a PDDEG-S
Ethernet Gateway is still required to ensure the secure
connection between the PDZG-E Wireless Gateways
and the DyNet network.
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2.1.4 Controllers

Store Flex

The correct combination of control components creates

a robust controller network and brings the highest level

of lighting control flexibility to a store, enabling:

e Wired load controllers (for example: DALI Broadcast,
DALI Addressable, DMX, 0-10V, Relay)

e Wireless devices (Philips wireless luminaires, SC100 IA
transceivers)

e Daylight & occupancy sensing via DyNet sensors to
dynamically adjust lighting to local conditions

e Scene control with dimming & zoning

e Local manual override, plus integrations with
Building Management Systems (BMS), alarm systems,
etcetera

(=) Note
Currently, sensing and data collection is not
supported via wireless nodes like the SNS210 IA.
Itis possible to use DyNet or DALI sensors instead.

2.1.5 Topology

Wired architecture

In the wired architecture, the central store controller
connects to the control equipment by means of DyNet
via RS-485 or Ethernet cabling. Luminaires are connected
to the load controllers, depending on the type of
luminaire, by means of power and/or control cables.

Wireless architecture

In the wireless architecture, the function of the load
controllers is taken over by the PDZG-E Wireless
Gateway, that connects wireless devices to the
associated network. The Wireless Gateways are via
Ethernet connected to the PDDEG-S Ethernet Gateway.
Each Wireless Gateway can join a wireless network that
can consist of up to 60 wireless nodes.
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Wireless Group Control (WGC) is also possible, which is
wireless control of a DALI broadcast group. This can be
achieved by using one of the following devices:

SC100 IA transceiver with a Xitanium SR Bridge

A SR transceiver connected to the SR interface of
the Bridge enables control of a group of luminaires
via the DALI interface of the Bridge and the mains
relay integrated in the Bridge. The Bridge supports a
maximum of 20 DALI drivers per SR Bridge or up to
400 VA switching capacity . See the specifications of
the SR Bridge for all details.

SC100 IA transceiver with a DALI Extender

Extends the SR bus, to which a SR transceiver can

be connected, to the DALI bus, enabling multiple
applications. The DALI Extender supports up to

20 DALI drivers. See the specifications of the DALI
Extender for all details.

(=) Note

It is possible to use the SC100 IA in combination
with SR-driver as applied in certain luminaire
ranges. Check the documentation of the SC100 IA
for more information.

Currently, sensing and data collection is not
supported via wireless nodes like the SNS210 IA.
Itis possible to use DyNet or DALI sensors instead.
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2.2 Formats and application

2.2.1 Formats

|
A 0000

Express & convenience

Convenience stores and express formats are
smaller local stores.

Characteristics

e Stores with a smaller assortment

e Convenient formats are found in smaller
villages, city centers or for example
holiday resorts

e Express formats are typically found in places
with high traffic

Typical size
Floor area: =500 m?
Light points: <200

& Chapter contents
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Stores in this format are typically larger
supermarkets, fashion, and DIY retail formats.

Characteristics

e Stores with a large assortment

¢ Supermarkets and fashion retails found in all
kinds of shopping areas, e.g., city centers

¢ DIY retails mostly found at the edges of a town

Typical size
Floor area: 500 to 3,000 m?
Light points: 200to 1,000

=l=

This format includes all very large stores that
often have more assortments than groceries
alone, or department stores.

Characteristics

e Stores with multiple assortments

e Hypermarkets/Wholesalers mostly found at the
edges of a town

e Department stores often in the city centers

Typical size
Floor area: 3,000 to 10,000+ m?
Light points: 1,000 to 5,000+
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2.2.2 Typical application examples
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Express & convenience

DALI addressable

]

b

| | b4

DALI addressable

Jﬁ

&

Hypermarket

DALI addressable

Controls Controls
Ethernet gateway 1x PDDEG-S/PDEG/PDTS Ethernet gateway 1x PDDEG-S/PDEG/PDTS
DALI control 3x DDBC120-DALI DALI control 16x DDBC120-DALI
or: Ix DDBC320 DALI or: 6x DDBC320 DALI
Relay control 1x DDRC420 Relay control 1x DDRC1220
Dry contact input 1x DDMIDCS8
Multi-sensor 3x DUS360CR

DALI broadcast

DALI broadcast

DALI broadcast

Controls
Ethernetgateway  1x PDDEG-S/PDEG/PDTS
DALI control 80x DDBC120-DALI
or: 28x DDBC320 DALI
Relay control 3x DDRC1220
Dry contactinput 1x DDMIDC8
Multi-sensor 15x DUS360CR

Controls
Ethernetgateway  1x PDDEG-S/PDEG/PDTS
DALI control 1x DDBC1200
Relay control 1x DDRC420

Controls
Ethernetgateway  1x PDDEG-S/PDEG/PDTS
DALI control 1x DDBC1200
Relay control 1x DDRC1220
Dry contact input 1x DDMIDCS8
Multi-sensor 3x DUS360CR

Controls
Ethernetgateway  1x PDDEG-S/PDEG/PDTS
DALI control 25x DDBC120-DALI
Relay control 3x DDRC1220
Dry contact input 1x DDMIDCS8
Multi-sensor 15x DUS360CR
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2.2.3 Application example for the wireless architecture
The example shows a building equipped with wireless
luminaires and luminaires controlled via Wireless Group
Control, connected to in total two Wireless Gateways.
With each Wireless Gateway connected to an Ethernet
switch, the system saves considerably on control cabling
and installer time.

When designing a system layout, keep the following
guidelines in mind:

Location of the Wireless Gateway

The best location of the Wireless Gateway is in a high-
density grid, with as much nodes as possibles within
reach, but at least more than two nodes in reach.

(=) Note
The maximum distance is limited to the application,
see the recommended maximum distances on the
next page.
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Figure 1. Application of wireless luminaires in an open space

| b1 |

Figure 2. Application of wireless luminaires in a corridor

Maximum number of devices:
e Each Wireless Gateway can join a maximum of 60
wireless nodes to its network.
e With Wireless Group Control:
e ASRbridge controls maximum 20 DALI
luminaires, or up to 400 VA switching capacity.
e ADALI extender can connect to a maximum of 20
luminaires.

Recommended maximum distances:

e Keep the cable length of each Wireless Gateway to
the Ethernet switch limited to 100 m (328 ft).

e In ceilings (recessed luminaires or nodes, for example
in offices) the distance (D 1) between two nodes is
maximum 10 m (33 ft). See figure 1.

e When installing in a corridor, use half the distance
(D2) between two wireless devices to ensure that
there will be always a second device (D1) in reach in
case one of the devices fails. See figure 2.
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2.2 Formats and application

Channel selection

As each Wireless Gateway creates its own wireless

network, it is important that these networks don't

interfere with each other. Zigbee uses the channels 11,

15,20 and 25.

e Avoid using channel 11 as it overlaps with Wi-Fi

e Usage of the channels 15, 20 and 25 is recommended,
with a preference for the channels 20 and 25

The system offers easy identification of the wireless
devices by using the Philips Dynalite Enabler app in
combination with discovery by means of Bluetooth.
These devices can be assigned to their respective area or
zone in the app.
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2.3 Upgrade scenarios
Store Flex systems using the PDDEG-S Ethernet Gateway

are upgradable to Multisite. Also, the other variants of
the Dynalite for Retail are upgradable to Multisite.

Rollout scenario Rollout scenario Rollout scenario
¢ Philips Dynalite controls ¢ Philips Dynalite controls ¢ Philips Dynalite controls
e Philips LED luminiaires e Philips LED luminiaires ¢ Philips LED luminiaires
e Lighting design e Lighting design e Lighting design

¢ Project management ¢ Project management

e Controls design e Controls design

e Commissioning e Commissioning

e License activation

Upgrade scenario Upgrade scenario Upgrade scenario
e Add orreplace PDEG by PDDEG-S e Add orreplace PDEG by PDDEG-S

e Controls design review (if not yet equipped with a PDDEG-S)

¢ Commissioning e Controls design review

e Request and activate licenses e Commissioning

e Request and activate licenses
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Intake

The aim of the intake is to allow to tailor the solution
exactly to the needs of the customer. What are his
exact demands and how should the lighting system
be engineered. For this it's important to have some
knowledge of the theory behind the system.

3.1 System capabilities

The design of Store Flex projects is crucial since the
allocation of the areas may be achieved by separating
the physical channels, which can be done by means of
wiring. The Store Flex system supports multiple types
of control components, like DALI broadcast, DALI
addressable, phase-cut dimming controllers, relay
controllers, etcetera.

The Store Flex system can be tailored to all kinds of retail
formats.

3.1.1 Areas

Per retail format the areas are defined at a high level.
Depending on the size of the format, it's possible to
define multiple areas. A maximum of three areas can be
created, for example:

e Sales Floor

e Back of house

e OQutdoor

3.1.2 Zones and Channels
Per area you can identify up to 48 zones, for example on
the Sales Floor:

e Bakery

e Meat

e Cash registers
Etcetera

Each zone is represented as a logical channel, which can
be either dimmable or switchable. To make sure that the
name of the zone is visible in the Store Control Ul, each
channel should be given the same name as the zone it
corresponds with.
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3.1.3 Scenes and Schedules

For each area you can create scenes:

¢ Indoor area: 32 scenes

e Outdoorarea: 32scenes (with day/night mode)

The system accommodates a maximum of 100 schedules
of which up to five need to be reserved for standard
configuration. The Ethernet Gateway takes care of the
execution of the schedules.

The schedules need to be aligned with the needs of the
customer and configured before handover of the system
and can be edited afterwards using the Store Control Ul.
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3.1.4 Store Control Ul

A preconfigured Store Control Ul package is readily
available for download on the MyLighting portal.
Uploading of this package is done using System Builder.

The Store Control Ul is a web-based interface that runs
on a web browser installed on a device, independent if
the device runs on Android, iOS, MacOS, or Windows,
or on the dedicated PDTS touchscreen. The software
recognizes the type of logical channel and adapts the
user interface to it, showing a slider for dimmable
channels and a switch button for a switchable channel.
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3.2 Users and user roles Controls designer
The controls designer combines the information
Below an overview of the users and the user roles that provided in the project template and the reflected

ceiling plan using the System Builder Design Mode
Offsite tasks Onsite tasks (System Designer). This is a powerful tool that provides

a quick and orderly process for designing a Dynalite

that are involved in the rollout of a Store Flex project. lighting control system.
Note that there’s a clear distinction between users
handling offsite and onsite tasks. (=) Note
A technician license of System Builder is required
3.2.1 Users handling offsite tasks before you can use System Designer. To request
Offsite tasks involve site preparation and design. this license, in System Builder click Help and select
License.
Lighting designer
The lighting designer uses the site layout/floor plan 3.2.2 Users handling onsite tasks
to create a lighting design, resulting in a reflected Onsite tasks like installation and commissioning typically
ceiling plan and luminaire count (bill of material for the require having someone present at the site.
luminaires).

Installer/site engineer

The designs require approval by the customer, after
which the products will be ordered and delivered. When
the site is ready for installation, the installer and/or the
site engineer can start their activities.
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3.3 Intake and rollout

3.3.1 Project template

All customer information as described in the previous
sections is collected in the Project Template (also known
as Intake Form, see the Project Template).

Each section corresponds with a step in the offsite
preparation of the project execution.

The information in the project template regarding the
lighting control zones, lighting plan and other control
options is used to prepare the project for commissioning.
See the section 4.3 Prepare the System Builder job file.

. . Onsite installation

Based on the project template, we prepare the digital
twin of the lighting system upfront, simplifying the
on-site commissioning effort so it can be done by your
installer or a site engineer.

3.3.2 Off-site and on-site activities

Offsite preparation
Trained experts carry out the off-site preparation that

consists of the following steps:
e Intake
e Complete project template and requirements
document based on customer input and
alignment
e System design
e Lighting design: creation of the reflected ceiling

plan
e Controls design: creation of the customized
project file
e Ordering

e Order products (lighting and controls)

@ Important
For projects that are configured with wireless
controls, it's important that the prepared project file
is saved in the cloud using a Dynalite account. Contact
your local Signify representative for requesting the
account.
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Onsite installation
The installer and commissioning engineer take care of

the on-site installation that consists of the following
steps:
e Installation
e Alllights and controls installed and functional
e Commissioning
e Downloading the latest device firmware versions
from www.dynalite.com;
e Commissioning of wired devices using System
Builder
e Commissioning of wireless nodes using the Philips
Dynalite Enabler app
e Download the Ul-files from the MyLighting Portal
e Validation
e End-to-end validation of controls and lights
e Final project file
e Site delivery
e Readytouse
e Handover of the site to the customer

3.3.3 System Builder/System Designer

For the controls design, the experts use System Builder. A
technician license of System Builder is required to enable
System Designer. This is a powerful tool that provides

a quick and orderly process for designing a Dynalite
lighting control system.

Onsite, System Builder is used to deploy the prepared
project file into the DyNet network.


http://www.dynalite.com

04 Offsite preparation

4.1 System design 4.4 Plan installation and commissioning

4.2 System Builder job file templates
4.3 Prepare the System Builder job file
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4.1 System design

Lighting design Control design
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4.1.1 System characteristics

During design and commissioning of a Store Flex system,

pay attention to the following system characteristics:

1. The Store Flex system combines a modular Dynalite
control topology with a user interface developed for
a retail store.
For Store Flex tested and verified load controllers, see
section 4.1.3 Controls design.

2. When implementing wireless controls, additional
supported components are added to the modular
Dynalite control topology. Systems with wireless
devices require additional attention during the
design process.

For tested and verified controllers, see sections
4.1.4 Wireless controls design.

3. There are System Builder (SB) job file templates
available for faster creation of a project specific job
file. These templates include a basic configuration.
The following templates are available:

e 2indoor areas, 1 outdoor area
e 1lindoorarea, 1 outdoor area
e 3indoor areas

e 2indoor areas

e 1indoorarea

These job file templates are all available using

a PDDEG-S as central store controller (preferred
option), but also with a PDEG or PDTS as central store
controller. For more information about the job file
templates, see section 4.2 System Builder job file
templates.

Important
Only the job files for use with a PDDEG-S are suitable
for application in projects using wireless controls.

Pre-design of the project area configuration is crucial
since the area allocation can only be achieved by
separating the physical channels by means of wiring.
The physical channels are mapped to the logical
channels which can easily be renamed to the specific
needs for these zones. For instance, Fresh food,
Bakery, etcetera. These names are shown in the Ul.
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4.1.2 Lighting design

The specific requirements of the customer and the
specifics of the site layout are considered when creating
the lighting design, that results in the reflected ceiling
plan and a luminaire count (lighting bill of materials).

Capturing the lighting design graphically in an
(AutoCAD) drawing influences the speed and accuracy
of the controls design.

Details of the lighting design can be provided in the
project template.

4.1.3 Controls design

While using System Designer, it generates:
¢ Bill of Materials (BoM)

e Projectfile

e Installation summary

e Wirediagram

e Load schedule report

Quantity of network devices

Theoretically, the RS-485 standard allows to connect an
unlimited number of devices to a data cable. Practically,
it's recommended to limit the number of devices per
gateway to 100.

In case the system requires higher numbers of devices on
the gateway, this is possible. For more information, see
the generic System Builder documentation.
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Power supply

Because several devices are powered over the network,
the quantity of consuming devices such as panels and
sensors need to be considered. Typically, most panels and
sensors will run between 10 to 15 Vdc at 25 mA.

In case of a large number of consuming devices, a
secondary power supply (DDNP1501) can be added to
boost the overall network voltage. The DDNP1501 can
supply 15 Vdcat 1.5 A.

In general, most Philips Dynalite load controllers
generate approximately 100 mA to the DyNet network
and will drive 4 or 5 consuming devices without the need
for a secondary power supply. Refer to the product data
sheets for calculation the power requirement for the
DyNet communication bus.

Make sure to use DyNet-STP-CABLE-LSZH
(or equivalent) cables.
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Tested and verified controllers for Wired

The specifications of each controller type limit the
number of luminaires that can be connected. Refer
to the product data sheets on www.dynalite.com for
detailed information.

DDBC120-DALI

e Single DALI control output, supporting one full DALI
universe of 64 addresses.

e One feed-through relay rated at 20 A (500 A surge)
for switching power to the drivers.

DDBC320-DALI

e Three DALI outputs, allowing to control up to 192
DALI devices.

e Three feed-through switched circuits rated at 20 A
for DALI driver mains supply.

DDBC1200

e 12 control outputs, selectable to DALI, 0-10 V/1-10 V.
In DALI Broadcast mode: 80 DALI drivers per channel,
300 total.

DDRC420FR
e Fourswitched feed-through outputs at 20 A
(inductive), maximum device load 80 A

DDRC1220FR-GL
e 12 switched feed-through outputs at 20 A (inductive),
maximum device load 180 A

DDMIDC8

e Eightdigital inputs, which can be individually
configured as dry contact or 0-24 V AC/DCinput

e Four0-5/0-10V analogue inputs

DDNG485

e Routes DyNet to third-party systems

e In DMX512 mode, capable of transmitting and
receiving 512 DMX channels


http://www.dynalite.com
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Tested and verified controllers for Wireless

PDZG-E Wireless Gateway

Seamlessly integrates wireless lighting control using
Zigbee PRO wireless communication

Ensures stable and robust lighting control in busy
environments by wireless mesh networking
Connects to the wired control topology ensuring full
compatibility

SC100 IA wireless transceiver

Operates with the established Xitanium SR driver
standard

Enables Wireless Group Control when connected to a
Xitanium SR Bridge or a DALI Extender

Xitanium SR Bridge

Controls up to 20 DALI drivers

Capable of connecting multiple drivers with a load of
up to 400 VA

Switches the connected drivers fully off, no standby
power

Programmable via the SR interface or SimpleSet.

DALI Extender

Controls up to 20 DALI drivers
Supports emergency luminaires

(=) Note

Currently, emergency lighting is not supported in the
Store Flex system.
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4.1.4 System wiring DALI cable cross sections
The maximum voltage drop on the DALI bus is 2 V.

Cable limits Therefore, use cables with the specifications according

to the table. DALI cables of over 300 m (1000 ft) are not

DyNet cable length allowed.

e When using the DyNet STP Cat 5 cable, the number of
Philips Dynalite devices is limited to 100. DALI conductor diameter

e The maximum Cat5 cable length between the devices
is 100 m.

e Anyother cable used for RS-485 data transmission
should be of the type STP with a characteristic <100 m <330 ft 0.5 mm? AWG 20
impedance the twisted pair between 100 to 120 Q. 100 to 150 m 330- 500 ft 0.75 mm? AWG 18

e The maximum current a single gateway can draw is 150 10 300 m 500 1000 ft 15 AWG 16

limited to 2 A.
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Ethernet cable length
The length of the Ethernet cables is limited to 100 meter
per run.

Built-in dry contacts

The maximum distance to the input source depends on
the type of connection and the device used to create the
connection. See the specification sheets of the specific
components for more details regarding maximum cable
lengths etcetera.

Physical connection testing

The in-store controllers have manual override buttons,
which will help the site engineer to confirm the correct
physical power connection. Control protocol tests can
only be performed with System Builder as a tool, or on
the mobile device, by moving the sliders in the Scenes
page for each channel. Refer to the respective product
installation guides for correct test procedures.
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4.1.5 Customer supplied components

Wireless access point

The Wireless Access Point (AP) establishes the
communication between the mobile device (for example
the tablet) and the Store Control Ul on the Ethernet
Gateway.

For this purpose, a consumer router shall be used. The

minimal specifications are:

e Standards IEEE 802.3, IEEE 802.11g, IEEE 802.11b

e Ports:
¢ Internet:10/100 RJ-45 Port
e LAN:10/100 RJ-45 Switched

e Firewall not required for standalone system.
However, PDTS needs Network Time Protocol (NTP)
access to keep displayed time synchronised or to
schedule access to the interface.

e Wireless security Wi-Fi Protected Access (WPA3).

Configure the access point

e Give the AP a comprehensible network name (SSID)

e Select a security method and configure a strong
password.

= Note
e Store the SSID and password in the system
documentation for future reference.
e Itisadvised to configure the Ethernet Gateway
with a static IP address, for example 192.168.1.50.

Tablet

Tablets add flexibility to the user for easy control and
arrangement of project settings without depending on
static/dedicated devices. Simply open any browser on a
tablet device and access the Store Control Ul via entering
the IP address of the Ethernet Gateway. For easy access
create a shortcut on the homepage of the tablet.

Recommended minimum requirements for a tablet are:

iOS Android

Version iPadOS 18 or newer Android 9to 13

Screen resolution 1536 x 2048 800x 1280

Web browser Recent version of Safari or Chrome
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4.2 System Builder job file templates (=) Note

The available System Builder job file templates facilitate e The table shows the template files available with

and significantly speed up commissioning. the PDDEG-S. Identical templates are available
with the PDEG or PDTS as store controller. Contact

There is a template available for each of the five the Signify System Experts for more information.

corresponding scenarios, provided the system limitation e The outdoor area is by default configured as

of maximum three areas (A). These areas can be either all Area 4.

indoor, or a mix of indoor and outdoor areas.

Select the preferred template that best suits the project
configuration.

System Builder job file template name Description

StoreFlex_PDDEG-S_Template1_2IA_10A 2 Indoor areas (A=2, A=3)
+ 1 Outdoor area (A=4)

StoreFlex_PDDEG-S_Template1_11A_10A 1 Indoor area (A=2)
+ 1 Outdoor area (A=4)

StoreFlex_PDDEG-S_Template1_3IA 3 Indoor areas

(A=2, A=3, A=4)
StoreFlex_PDDEG-S_Template1_2IA 2 Indoor areas (A=2, A=3)
StoreFlex_PDDEG-S_Template1_11A 1 Indoor area (A=2)
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allocation on store controller

(PDDEG-S/PDEG/PDTS)

Schedule n

N 6o v A WN

Indoor

A=2 A=3

Sunset

Sunrise

Default 3
Default4
Default 5

New Schedule 6

New Schedule 7

2IA_10A

New Schedule 100

Indoor

A=2 A=4

Sunset

Sunrise
Default 3
Default4

New Schedule 5
New Schedule 6

New Schedule 7

1IA_10A

e Eachjob file template includes the specified store
controller with 100 schedules already prepared.

e Intemplatesincluding an outdoor area, the first two
schedules are reserved for sunset and sunrise.

& Main contents

& Chapter contents

<& 4.2 System Builder job file templates

Qutdoor

New Schedule 100

Area number and type

A=2 A=3
Default 1
Default 2
Default 3
New Schedule 4
New Schedule 5
New Schedule 6

New Schedule 7

Template suffix

31A

In all templates, each area requires a reserved

Indoor

New Schedule 100

Indoor
A=2 A=3
Default 1
Default 2

New Schedule 3
New Schedule 4
New Schedule 5
New Schedule 6

New Schedule 7

21A

New Schedule 100

Indoor

A=2

Default 1

New Schedule 2
New Schedule 3
New Schedule 4
New Schedule 5
New Schedule 6

New Schedule 7

New Schedule 100

1A

schedule as system default: three areas equal three
reserved schedules (named Default #)
All schedules named New Schedule # give the end-

user the possibility to create new schedules directly in
the Store Control Ul.
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4.3

Prepare the System Builder job file

4.3.1 How to design the system
In general, the System Designer feature in System Builder
is used to design the system.

Benefits of using System Designer compared to classic
System Builder:

Standardized way of design and commissioning of a
system

Minimizing possible errors when following all steps
in the wizard

System Designer calculates the lengths of the DALI
cables and shows a message if the cable is too long.
System Designer keeps track of the load of the DyNet
devices and shows a message if the load is too high,
requiring an additional power supply.

System Designer produces reports that summarize
the total number and types of luminaires, controllers,
and other devices, as well as the total cable length.
This helps when creating a quote.

=) Note
You need a technician license before you can use the
System Designer feature in System Builder. You need
to raise a ticket to request such license; see section
6.1.1 Ticketing system (C4CS) how to do that.

® Tip
More information about using System Designer can
be found in the User Guide. Click Help > User Guides
and select the System Designer User Guide.

In this section we describe the steps to take using the
System Designer feature when creating the offsite
design of the system.
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6. Define Perimeter

14. Renumber Circuits and Devices

15. Select Hardware
16. Generate Reports ¥
17. Produce Documentation ¥

<& Main contents

& Chapter contents

& 4.3 Prepare the System Builder job file

4.3.2 Using System Designer

Open the System Builder job file template that best
suits your project and click the button Design Mode
(E]) to start the System Designer feature.

Use the buttons in the Window menu to switch

between the =] Properties Window and the ]

Floor Plan Wlndow.

When following the steps of the Design Assistant,

take care for the attention points below:

a. 5. Define Scale: Use Enter Background Scale when
you know the scale of the floor plan used.

Use Draw Background Scale to define the

scale manually. You can do this for example by
measuring the distance between doorposts or the
bay width of the shelves.

b. 7. Add Distribution Boards: Consider the expected
cable lengths when finding a good position for
the distribution board(s) on the floor plan.

¢. 10. Group Fixtures: Use Draw DALI Cable to
connect the DALI controlled luminaires, both
broadcast and addressable. Make sure to connect
the created universes with the distribution board.
Use Draw Fixture Group for switchable
luminaires.

41
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Mame Total Grouped
- 4 Circuits 1 dircuit
= @ Non-Dimmable La.. . 3 drcuits
#6 Switchabled1 4 fixtures DB1
#7 SwitchableD2 3 fixtures DB1
#9 SwitchableD1 7 fixtures DB1
By Al Universes 5 universes
- @ Universe 1 44 Fixtures
E- gy O Universe 2 40 Fixtures
- @ Universe 3 12 Fixtures
[+- @ Universe 4 4 Fintures
¢ [ @ Universe 5 2 Fixtures
e @E’ﬁ DyMet Cables 1 cable
(1) DyNet Cable 3 devic... DB1
Name Mumber
+- (@ Unassigned Area Al
(=) Default Floor
@ Sales area A2
E Back of house A3
@ Cutdoor Ad

(=) Note

Make sure not to exceed the maximum number of
devices on a DALI universe.

Make sure to add luminaires to the correct
universe, either broadcast or addressable.

10. Group Fixtures: After drawing the DALI
universes, a symbol (i_}J) shows that the DALI
cable is not connected to a distribution board (or
a controller).

Click Draw Line (“Hh) and select Draw DALI Cable
to connect the universe to a distribution board (or
a controller).

12. Draw Areas: Draw a maximum of three areas.
Give the areas a descriptive name and the ID
following the Project template.

@ Important
Always assign Area 4 to the Outdoor area
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f. 13. Draw DyNet Cable: When drawing Dynet

B Untitledlob / Revision '0.1' / Design |AR-multisite’ - Hardware Selector - O X cablesl also ma ke sure to connect the cable to
() Design » BREpnr‘ts ~ W Apply To Job Delete dle Rename (N Unassign _-.' Product Details . . .
| Perr— . preer a distribution board. If controllers are added to
Mame Area Assignet a
= IAR-multisite_Plan 100% = B9 1AR-multisite_Plan . N . . i 1
oot 100% o & st the distribution board in step 15, the symbol ([ ! ))
| B 4 Cirits = mm DDBC120-DALL L —
Pl on-Dimmable La... 100% - DALI Enumerated 1 o A Univer H
L O N:S Switchable01  Signage [+ DDRC420FR 2 5 Channel 1 e dlsappears'
#7 Switchable ignage [ = =am DDBC120-DALI 1/1 .
: 2;§'A'i1:d'|ablagi Eagrkingg L ggggﬂ {7 DALIEnumerated 1 #3) © Univer g 15 select Hardware: CI ICk open Hardware
| - Universes - Channel 1 . .
R L e o, SO Selector Window and in the left panel select a
o S # Circuitor @ Universe (added in step 7).
@ Universe 3 .
Fl g EERTERRL Select the controller of choice to add to the
| ] s e distribution board.
#5Broadcastd3  Store Mai.” DDBC1200 -
l‘} DyMet Cables
- DyMet Cable
) %51231332?;215.%1 < > B Note
i pam DDBC120-DALL : 7 : .
: -EBE):[;E;U:DIZUDALI View: Small lcons - | Filter Supply Voltage = Certifications = The SeleCtIOn o-f Con'trO”erS depends on the type of
El-Em Form Factors » Variants =
G- DRI Balst Contrallers universe. Universes spanning multiple areas must
+..pma DDRC420FR Em[DEC120-DALI = DDBC300-DALI sm DOBC320-DALI .
i DDBCS 1677 be assigned to a DALI addressable controller. For
[ 5 - Ballast Contrel Modules (DMC2 / DMC4) . . . .
IS s SWIOVDIIOCE  EEOMDYIGSE  SHOMDIEFALL more information, see Appendix A3 - Configure DALI
- 4, DUS360CR i\ DMD3TEUL ) o i
-8 e individual addressing
< >
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h. 15. Select Hardware: In the left panel, select a

B Untitledlob1 / Revision ‘0.1 / Design 'lAR-multisite’ - Hardware Selector — m} X Ci rcu i-t or DALI un iverse a nd assig n it by d rag a nd
() Design - BRepDrts ~ By Apply ToJob | 3¢ Delete dfe Rename ™, Unassign _-'y Product Details . . .
MName Area Assigned Available Devices Assigned drop to the approprlate ContrOI |er In the rlg ht
=B 1aR-multisite_Plan 100%

_ I;Ei;krl‘iv::orKDevices pa nel.

T = i. 15.Select Hardware: In the left panel, select all

i ! B @ NonDimmable Lamp {electro... 100% .

(] i Sl Lo added devices (load controllers, sensors, user

5 & #7 Signage Signage [ # DDRC420FF

¥ o3 #8 Parking Lot Parking Lt # DDRC420FF . .

P Lo T ? interfaces) one by one and click EI'E Rename to

FoioE niverse 1 (multi-area;

il ZE':E:;'Z) " R give each device a unique name.

£ 3 ?.ZSE|ES Floor 2 (multi-area) # DDBC120LC

. _ i U:;?:;:;a Storage [ # DDBC1200

Bhas - © Important

i [ @ Universe 5 . . .

| wro oo Give each device (controller, sensor, user interface) a

L . 2 unique name, for example by adding a consecutive

H - DDBC120-DALI (Fresh) View: Small lcons ~ | Filter: Supply Voltage ~ . P .

| TS - Cetications ~ Form Factors + Variants ~ letter or number, or any other identification (for
e POREAAR example: usage or location). The reports reflect the
H -mam DDRC420FR . . . . .
R names to help you identify which physical channel is
£ DUS360CR (Storagel) .
; * ousteocn sase connected to which controller.
= _.z.‘]erlnter BCES
- DI:.EDPE {Staff Lounge)

< > j- 15. Select Hardware: Click Apply To Job. Click

Yes to confirm. A message shows if any problem
occurs.
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Fixtures Grouped: D 100%

& Main contents

& Chapter contents

< 4.3 Prepare the System Builder job file

Close System Designer
Before closing System Designer:

Make sure the Fixtures Grouped indicator shows
100%.

Make sure there are no exclamation marks (g/@)
showing.

Follow the steps 16. Generate Reports and

17. Produce Documentation.

Click the button Design Mode ({:}) to close the
System Designer feature.
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<& Main contents

& Chapter contents

Figure 1. Possible result after using System Designer

< 4.3 Prepare the System Builder job file
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Mame Status
2 2% UntitledJob1
- | 2] MNetwork Devices
ey o
= | #] Load Contraollers
: -g=m DDBC120-DALI {Fresh) g_ﬁf
- gm DDBC 120-DALI (Groceries) .,Hj{
- m DDBC1200 o=
; ‘.. pmmm DDRC420FR ijj{
= | o|| User Interfaces
Lo -[F| PADPE (5taff Lounge) o=
B[ o] Sensors
DUS360CR. (Storage1) U=
DUS350CR (Storage2) o=
Mame Status
=3¢
= | #] MNetwork Devices
E- p¥=a o/ PDDEGS o=
= || Load Controllers
- - zam DDBC120-DALI {Fresh) o=
gmm DDBC120-DALI (Groceries) o=
- pm DDBC1200 o=
= DDRC420FR o=
= | :]] User Interfaces
- [ PADPE (5taff Lounge) o=
B-| ] Sensors
DUS380CR (Storage 1) o=
DUS380CR (StorageZ) o=
< Main contents < Chapter contents < 4.3 Prepare the System Builder job file

4.3.3 Configure the job file
Once you added all devices to the project file, you can
further configure the job file.

Create topology

1. Press Shift to multiselect the Load Controllers, and if
applicable also the User Interfaces and Sensors.

2. Move the devices under the PDDEG-S. Click Yes to
confirm.
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Areas View o x
) W~ 0 e B2 & v =
Name Number = Loca
= # g Untitledlob2
) Unassigned Area Al
=)~ @ Sales Area A2
@ Fresh food C1
@) Fish &Meat
© GRS I
@ Back of house
@ Outdoor A4
Areas View o x
Bae-9 N\ A -
Name Number
# J untitiedob2
+)- (@ Unassigned Area Al
() Store Flex
- @ Sales Area A2
1 @ Back of house A3
—J- [@ Outdoor A4
fp Sian Ci
e Outdoor-Sign [DDRC42...
#3 Outdoor-Sign-2 [DDRC...
& Parking C2

< Main contents < Chapter contents < 4.3 Prepare the System Builder job file

Create logical channels (DALI broadcast)

1.

In the Areas view, select the desired Area, for
example Sales Area.

Click ¥ Insert New Channel to create a new logical
channel.

Create the logical channels according to the project
template, with a maximum of 48. Give the channels a
descriptive name that corresponds with the zone.

Important
Make sure to add a logical channel with the ID C1 in
each area.

Link each physical channel with its logical equivalent
by means of drag and drop.

Repeat for all logical channels in areas using DALI
broadcast.
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Areas View

Dae-9INHRERLG T

B X | AreaProperties Presets Outputs Area Devices L

-
]

z New - @& &a &5 Synchronise -
Name Number
Num Preset N T A
= 3¢ [ Untitiedlob2 o amne o
(8 Unassigned Area Al )
) Store Flex On User -
- B Medum e -
@) Cashiers Ci Low User -
) Fresh food c2 Off User =
Gl P_ha"“aw c3 = | Store Closed User -
@ Fish &Meat Cc4 Stocking s =
@ Drinks cs s U o
@ Bakery c6 : , P =
+ [@ Back of house A3 — Cleaning User b
5 @ Outdoor A4 = 5 |Preset3  |Hidden [
E Preset 10 Hidden A
E Preset 11 Hidden -
= Preset 12 Hidden -
E Preset 13 Hidden -
E Preset 14 Hidden bd
< > E Preset 15 Hidden b
@ Areas |E! System | @ Building | =] Preset 16 Hidden = i
< Main contents < Chapter contents < 4.3 Prepare the System Builder job file

Prepare presets for the Indoor areas
The presets in System Builder enable the creation of
Scenes in the Store Control Ul.

Each System Builder job file template consists of 64
presets for each indoor area. By default, eight of the
presets will become visible in the user interface of the Ul
(marked in blue), where the hidden presets are prepared
for use.

1. Inthe Areas view, select an Indoor area (Area 2 or 3).

2. Change the name and the settings of each preset
according to the Project template.

3. The customer can edit the names and settings after
commissioning in the UL.

4. After commissioning, you can use the Ul to make
any of the hidden presets visible for usage in the
interface.

49



04 Offsite preparation

Area Properties  Presets  Qutputs  Area Devices  Unassigned
New - 23 [ | By synchronise ~ Reqy

Mum  Preset Name Type

High User -
Medium User s
Low User -
Off User -
Dimmed 70% User i
Dimmed 30% User B

Request Levels

Low {2) Duplicate =
Off (2) ) -
Dimmed 70% =2 Copy -

Dimmed 30% ([ Paste =

Il K5 K5 I I D D D D
[]

Delete

afe  Rename

Area Properties  Presets  Qutputs  Area Devices  Unassigned

New - %S}fnchronise - Reqy
Mum  Preset Name Type
= High User i
Medium User <
Low User -
Off User -
Dimmed 70% User i
Dimmed 30% 6 User v
High Hidden -

m Medium User -

Low

Off

Dimmed 707
Dimmed 307

Prepare presets for the Outdoor area

The astronomical clock of the Ethernet Gateway allows
for using the Day & Night Mode. The Day & Night Mode
is available in the outdoor area only and is configured by
using Preset offsets.

Each System Builder job file template including an
outdoor area consists of four presets. If required, it is
possible to add more presets:

1. Inthe Areas view, select the area Outdoor (A4).

2. Select the presets 5to 8 and click Delete x.

3. Addthe day mode presets. You can add presets up to
a total of 32.

4. Change the name and the settings of each preset
according to the Project template.

5. Select all day modes presets and click
Duplicate &. Change the name of each duplicated
night mode preset, making them all identical to the
day mode presets.

6. Change the Type of the night mode presets to
Hidden.
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Set Preset Offset: Area - Outdoor [4], Join - OxFF| Offzet - 6 Area |Outdoor [4] | !
Reset Preset: Area - Outdoor [4], Fade - 00:00:02.000 loin @@\ ® |5 ® S| oxFF

Offset | [
Add action below selected action

< Main contents & Chapter contents

< 4.3 Prepare the System Builder job file

In the System view, select the Ethernet Gateway and
click the tab Schedules.

Scroll down and select the schedule Sunrise.

In the section Start Actions, click Edit Actions. Adjust
the Offset to the total number of day presets, in this
example: 6. Click Ok.
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Device Properties  Motion Control

Light Contral - [Josao

= Logical Address

Logical Area Back of house [3]
Logical Channel All Channels [0]
81
BLA Dizabled
Device Properties  Motion Control  Light Control - C|0580
2=8] | = Advanced | {== Graph
= Logical Address
Logical Area Sales flog
Logical Channel Zone 10
Join 22}
BLA Dizabled
= | IAEF‘E*"-ABF‘S Switch Enabled
' ' = Logical Address
BB |Dycortact4 |A20n/0F || | (il prea Sales fioor [2]
m | Dry contact 5 | A3-On/Off Logical Channel All Channels [0]
Dry contact § | PANIC NO Jein &3
—u T g BLA Disabled
_ Dry cortact 7 |PANICNC ||,
Preset: Area - Sales floor [2], Join - 0xB4, Preset
Dw Con‘tact _l|" PIAN“: N[: rFuncuon Lustom

DyMet1 logical messages - Pu'eaein

Configure inputs

Allinputs, like sensors, user interfaces, dry contacts as
well as some of the schedules, require specific Join byte
configuration.

Make sure to configure all inputs with the correct Join
byte:
1. Motion control on sensors
e Change the Join byte 81 (0x81)
2. Light control on sensors
(daylight harvesting)
e Change the Join byte to 82 (0x82)
3. Userinterfaces
(like Antumbra, Revolution or third party dry
contact):
e Change the Join byte to 83 (0x83)
4. Default schedules
(except the Sunset and Sunrise schedule):
e Change the Join byte to 84 (0x84)
5. BMS automation, dry contacts
(like Alarm/CCTV integration)
e Change the Join byte to 85 (0x85)

oy o AL

Release actions DyMet1 logical messages - Area: 2, Join

Extended press a...
Extended releasze. .

No action
DyMet1 logical messages - Area: 2, Join

& Main contents

& Chapter contents

< 4.3 Prepare the System Builder job file
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< Main contents < Chapter contents < 4.3 Prepare the System Builder job file

Save job file

1.

On the File menu, click Save As and select Save As
Job File.

Store the job file at a logical location and give it a
recognizable name.

Close the job file. You need it during onsite
commissioning.
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& Main contents

Areas View
y = i
QW9-9 N\ |4 & ¢ © &L
Name Number
2 # | Testira
@) Unassigned Area Al
+)- [@ Sales Area A2
+- [@ Back of House A3
-] [@ Outdoor ..:\4
& Canopy
-] Pariong =
Channel Properties
Number 3
Name Parking
Description
Location
Category Lighting
ZgBee E
=/ Channel Load Not Set
Lamp Wattage Leading Edge
Lamp Quantity ;:wllng Edge
Total Wattage il Syvoks
DSl
LED
Volt Free
Fan
DALI
Leading Edge 4Amp
Curtain
DMX Tx
Type Green
The type of fixtures that will be connected to the circuits that will be assigned to this | Red
Blue
Wl;m\ ‘White
Cool White
10w Simple Commands Tunable White
DMX
Progress Type Details Coded Mains
RGBWAF

Area Properties Presets Outputs Area Devices Unassigned Devices Tags  Template Manage

New - g B3 (3 | B Synchronise - Request Levels
Num Preset Name Type N | Name Flash | Level Exclude | Level
Canopy O O 100%
BT -] : corcing O O 100%
Medium User -
E Low User -
E Off User -

& Chapter contents

< 4.3 Prepare the System Builder job file

4.3.4 Configure wireless in the job file
Follow the instructions below when configuring wireless
luminaires.

Prepare the logical configuration
e Make sure to create upfront the necessary Areas and
Channels.

=) Note
Adding wireless nodes is only possible when the areas
and channels are predefined.

e Optionally, in Channel Properties, set the channel
type to Zigbee.

e If already known, define the names and levels of the
Presets.
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Configure Site Gateway

o] 1. Inthe System view, select the PDDEG-S.
e‘:hnnse::’l;t:’e‘mrevﬂsd%nr Ethemet/Fthemet application for your gateway. : .‘.' . n e Vic men U, Se eC i i u i
PP —— } 2. Onthe Device lect Bridge Configuration
Wizard.
D e R L 3. Onthe Select Application Type page, change the
OBt Pecses Poxd. T e B . .
(O Ethemet to RS-485 Translation Gateway devices. fol IOW| ng Sett' ngs:
(®) Ethemet to Ethemet Translation Gateway .
O et P Mt Gty a. In System Selection, select Ethernet to Ethernet
(O ot Foor Bremet Gty Translation Gateway.
b. In Ethernet Services:

Configuration Selection Ethemet Services

Camecions SwclPutidive  Gaowe (b) * Select the Static IPv4 Address checkbox.
Address Ranges [192.188 . 1 50 | [192.188 . 1 1] .
Mencs Subnet mask DN senver For dynamic IP addresses, see the note on the
[255.255 256 . 0 | [192.18B . 1 . 1 |
Web Server iy neXt page.

e Setthe/Paddressto:192.168.1.50
e Setthe Gateway to:192.168.1.1
e Setthe Subnet mask to: 255.255.255.0
o Setthe DNS serverto:192.168.1.1
e Select the Web Server checkbox
Click Next.

Next > Cancel

= Note
When using an IP address in a different range, make
sure that all IP addresses are in the same range, for
example: 192.168.178.x.
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Configure Connections

"Trunk Connection” will be used between Philips Dynalite System Manager and Ethemet Gateway devices. "Inter-spur Connection” is
onnection between Ethemet Gateway devices with common Areas. "Spur Connection” is connection between Ethemet Gateway device
d PoE or Wireless gateways behind it.

Trunk Connection

Connection Type TCP IPv4

Fort 50000

“E=)

Enable Web Socket / Cloud Connection / BACnet

Ethemet Spur Connection

Connection Type TCP IPvd

Port 50003 £
RS485 Spur

Enable RS-485 Spurfor Hybrid / Dynalite

[ Configure RS-485 as Modbus

< Back Cancel
Port Type, Index Connection  Description

== Comm Port 1 1.1 Spur Baudrate: 5600
[_;: IPv4 Port 1 2.1 Trunk UDP Client, IP: 255.255.255 255, Port: 5538
[#] IPv4 Port 2 2,2 Trunk TCF Server, Port: 51443, Secure
[_;: IPv4 Port 3 2.3 Spur TCP Server, Port: 50443, Secure
¥ Web Socket /.. 5.1 Trunk

On the Configure Connections page, change the

following settings:

e In Trunk Connection, select the Secure checkbox.

e In Ethernet Spur Connection, select the Secure
checkbox.

e Incase of adding DyNet devices (for example
sensors), select in RS485 Spur the Enable RS-485
Spur for Hybrid / Dynalite checkbox.

Click two times Next and click Finish.

Keeping the PDDEG-S selected: on the tab Ports,

check if System Builder created the following ports:

e TCP Server secured port for Trunk

e TCP Server secured port for Spur

Note

Configuring the PDDEG-S Ethernet Gateway with a
dynamic IPv4 address (DHCP) is also possible. In this
case, the router or switch to which the PDDEG-S is
connected should reserve a specific IP address for
the MAC address of the PDDEG-S. Any details of this
method are not described in this document.
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Mame Status
=) 3% Untitedlob2
= WNetwork Devices
¥ == &2 [B] [ PODEG-S = i
..-r'l =| '-r.lij
¥ =| o= PDIGE o=
Mame Status
=4 Untitledlob2
= [ WNetwork Devices
5 e o 0] [ = 4\
= [ MNetwork Devices
#¥ = o= PDIGE o=
#¥ = o~ PDIGE o=
Paort Type, Index Connection  Description
f_? |Pw4 Port 1 1 Trunk TCP Server Port- SO000
[ (] 1Pv4 Port 2 2.2 Trunk TCP Cliert, IP; 192.168.1.50, Port: 50003 ]
~ZigBee Fort | 1 Spur Zighes endpoirt: 65535

Add Wireless Gateways

1.
2.
3.

In the System view, click # Insert Device from List.
Select the tab Network Devices.

Under Gateways — Wireless Gateway, double-click the
PDZG-E.

The PDZG-E is added to the topology.

If required, repeat to add more PDZG-E Wireless
Gateways.

Create topology

1.

Press Shift to multiselect the PDZG-E Wireless
Gateways.

Move the devices under the PDDEG-S. Click Yes to
confirm.

For each PDZG-E Wireless Gateway: on the tab Ports,
check if System Builder created a TCP Client secured
port that points to the IP address of the PDDEG-S
Ethernet Gateway, so traffic is automatically routed
to the Ethernet Gateway.
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System View 1 x

A (EH-ARD EBEE

Device Properties  Connection Settings

Ports  Routing Area Cascadin| * | *

Narne
- 3% UntitledJob2

= [ Metwork Devices
= @¥em A @] [ PoDEGS
=[] Metwork Devices

¥ = o~ DESEH

¥ = o= PDIGE

=/ Device Identification ]
Device name PDZG-ED
Location
Description
Box number Unassigned
Serial number {stored in job only) 0
Device location sequence Unassigned
System designer device number Unassigned
IPv4 Address 0.0.0.0
|PvE Address 0:0:0:0:0:0:0:0
= Product Information
Product name PD2GE
Product category Gateway
Product type Wireless Gateway
Device code PDZG-E-V2 (IxC5 v

Device name
Used to identify the device.

System View R X | Device Properties Connection Settings  Ports ~ Routing  Area Cascadin| 4 | *
EEE-&E BREE | | || Advanced | Filter:
Name Metric poling startup delay (sec) Default -
- 3% UntitledJob2 = DyNet Watchdog
= [ Metwork Devices Watchdog Disabled
= pg Lm'sz I]k ;DD.EG'S Obey messages after timeout Falze
bt R Watchdog run at startup True
’: =) o Watchdog timeout {rounded to 10 ms) | 00:00.000
2] 0= FDEEE Watchdog Preset Current Presst
= Features
Enable area link for optional opcodes | True
Include controller in Localise By Sea...  Enabled
=" ZigBee
ZigBee channel number 15
PAN ID {hex 11
Extended PAN ID {hex
ZigBee Scene Transition (Fade) Tim... %2
1

.@,Area: 28 System | @ Building |

ZigBee channel number
ZigBee channel number

& Main contents

& Chapter contents

< 4.3 Prepare the System Builder job file

Configure Wireless Gateways

1. Inthe System view, select a PDZG-E.

2. Onthe tab Device Properties, in the section Device
Identification, give the device a unique name.

@ Important
Give each PDZG-E a unique name, for example by
adding a consecutive letter or number, or any other
identification (for example: usage or location). This
helps you identifying the correct Wireless Gateway
when assigning the luminaires as the name also
shows in the Philips Dynalite Enabler app.

3. Scroll down to the section ZigBee, select a ZigBee
channel number.

=) Note

e Usage of the channel numbers 15, 20, 25 is
recommended, of which channels 20 and 25 are
preferred.

e In cases that there is a need of using identical
channel numbers, always make sure that these
channels don't overlap each other in the physical
space.

58



04 Offsite preparation

Systemn View

23

H-aE REE %E;‘%Lhéﬁdvanced

Narne
-3
=)

b} Area

UntitledJob2
[ Metwork Devices
= @¥em A @] [ PoDEGS

=- [ MNetwork Devices

¥ = o~ DESEH

¥ = o= PDIGE

s |28 System | i Building |

1 X | Device Properties Connection Settings Ports  Routing  Area Cascadin * | *

~ IPv4
Use static IP address True
IP Address 152.168.1.101
Gateway 192.168.1.1
Subnet mask 255.255.255.0
192.168.1.1
DNS server
@) Add ~ ¢ Delete S, [5=12) |

Port
[#] 1Pv4 Port 1
(™) 1Pv4 Port 2
%+ ZigBee Port 1

Type. Inde
2.1
22
41

. On the tab Ports, in the section IPv4, set the Use static

IP address either to:

e False

The gateway obtains a dynamic IP address from

the PDDEG-S Ethernet Gateway, no additional
configuration required.

e True

Configure the static IP and network settings manually
using the steps below.

. When configuring a static IP address, manually set:

e |Paddress: consecutive in the same range as the
Site Gateway (for example: 192.168.1.101 for
Wireless Gateway 1, 192.168.1.102 for Wireless
Gateway 2, etcetera)

e Gateway:192.168.1.1

e Subnet mask: 255.255.255.0

e DNSserver: 192.168.1.1

Repeat for the other PDZG-E Wireless Gateways.
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ud Add - Delete

EJ Legin Online Account x
Environment: | Production e
Region: Global L
Email D:

Cancel
Close

. Dynalite Cloud Online - me @signify.com, Global

4.3.5 Save job file to the cloud (wireless only)

Once the preparation of the job file for wireless is
finished, it needs to be uploaded to the cloud to make it
available for onsite commissioning.

Login to the cloud

1.
2.
3.

On the Tools menu, click Interact Accounts.

Click -2 Add and select Dynalite Cloud Account.

For the first time, select:

e Environment: Production

e Region: Global

e Email ID: the registered email address

Click OK.

Select your account to login to. If required, fill in your
password.

Note

e Your user account must be registered before you
can login to your Interact Account. This account
can be requested via sme.interact-lighting.com

* The status bar at the bottom shows your
connection status and the region you're
connected to.


http://sme.interact-lighting.com

04 Offsite preparation

Save job file

Save As Dynalite Online Job File B 1. On the File menu, click Save As and select Save Job
To Cloud.
S— 2. If applicable, select the Organization.
e d 3. Provide a File Name and optionally a Description.
Job Files Click Save.
Name Description Last Modffied

@ Important
Saving the job file to the cloud is only applicable for
projects that are configured with wireless controls.

Fle Name: [UnttiedJob2 |

Description: | |

Save Cancel
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Projects

Project Name &

& Main contents

Address + Licenses s Valid until +

Add user

Email *

:

Status s Last Modified +

NA 21-02-2024 09:58:44 b

& Chapter contents

< 4.3 Prepare the System Builder job file

Account management

The person who saves the project to the cloud is the
project owner. Only project owners can provide other
Interact accounts access to the project using the Philips
Dynalite Cloud Platform.

w

Open the webpage dynalite.interact-lighting.com

and login with your credentials.

In the project list, select your project.

In the tab Users, click Add user.

Provide the email address and select a role:

e Viewer: user has read only access

e User: user has write access

e Owner: user is project owner and will be able to
add other users

Important

Added users must have an Interact account.
This account can be requested via
sme.interact-lighting.com.

Note
For commissioning activities with the Philips Dynalite
Enabler app, minimum User rights are necessary.
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4.4 Planinstallation and commissioning

4.4.1 Order hardware

In System Designer, following step 16. Generate Reports
and 17. Produce Documentation you created the files
that provide you an overview of the hardware to order.
In the Project Template, search for the Bill of Materials
(BoM) for both controls and luminaires. Filling in these

pages helps you to process the ordering of the hardware.

4.4.2 Prepare commissioning
Before starting with commissioning, make sure:
e thata USB PCnode and Ethernet cable are available;

=) Note
Use a computer with Windows 11 installed on it to
connect via the USB PC Node.

e to have a computer with the latest version of System
Builder installed on it;

e todownload the latest firmware of the controllers
from www.dynalite.com;

e when using the PDEG Ethernet Gateway as central
store controller: to download the firmware package
with version 3v54b3 from the MyLighting portal;

e todownload the Store Control Ul packages from the
MyLighting portal;

e toagree with the IT department of the customer on
the IP address of the Wireless Access Point.


http://www.dynalite.com

04 Offsite preparation

4.4.3 Install Philips Dynalite Enabler app

@ Important
Installing the Philips Dynalite Enabler App is only Before going onsite, install the Philips Dynalite Enabler
required for projects that are configured with app on your phone. The app is used to:
wireless controls. e Discover the wireless luminaires via Bluetooth,
e Assign the wireless luminaires to the correct Wireless
Gateway
e Testthe wireless communication of the wireless
network

Download the Philips Dynalite Site Enabler For Android, go to the Play Store. Search for ‘dynalite
app enabler’, select and install it.

The Site Enabler app is supported on Android For iOS, go to the App Store. Search for ‘dynalite
dynalite and iOS. enabler’, select and install it.

PHILIPS

< Main contents < Chapter contents < 4.4 Planinstallation and commissioning 64
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PHILIPS
P

Select your region

& Main contents

& Chapter contents

Login to the app

PHILIPS 2.

dynalite 3.

4,

Choose the .syftem you v.vant to 5.
commission to log in

6.

@® Dynalite [9

O  Multisite System Manager

< 4.4 Planinstallation and commissioning

It's recommended that the commissioning engineer
checks upfront if the Site Enabler app functions as
expected and prepares for the onsite commissioning.

. Open the app on your device. For the first time, select

the checkbox to agree with the Terms of Software
Service.

Select your region: Global

Select the system you want to commission: Dynalite.
Enter your username (email address). Tap Next.
Enter your password. Tap Sign in.

Select the project to commission.

Note

e An active internet connection is required to
synchronize between the Philips Dynalite Enabler
app and the Dynalite cloud.

e Atleast you need to be registered as User to the
project. Contact the project owner to create an
account with sufficient access rights.

e Use the same account details to login to the
Dynalite cloud in System Builder.
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5.1 Prerequisites 5.4 Install and configure the Store Control Ul
5.2 Wired commissioning 5.5 Create and install certificate
5.3 Wireless commissioning 5.6 Verification and handover

& Main contents 66
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Onsite commissioning

Before you start with the onsite activities, make sure to
complete to plan the installation and commissioning
well in advance. See the sections 4.4 Plan installation and
commissioning for more information.

This chapter describes the onsite commissioning of a
system in the following situations:
e Wired commissioning, for projects with wired

luminaires only. See section 5.2 Wired commissioning.

e Wireless commissioning, for projects with wireless
luminaires, and hybrid projects with wired luminaires
too. See section 5.3 Wireless commissioning.

Onsite activities consist of the following:

Installation and wiring of the luminaires, including
for example power and DALI, following the local
guidelines and directives.

Installation and wiring of the Dynalite network
controllers, including sensors and user interfaces,
according to the documentation produced during
the offsite preparation.

Additional commissioning of the controllers,
assigning the luminaires to the correct areas, zones,
and logical channels.

If applicable, installation and setup of the Wireless
Access Point for use
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Onsite commissioning

5.1

Before starting with commissioning, make sure that the

Prerequisites

following steps are completed:

Luminaires installed, wired, and powered ON
Controllers are installed in the distribution board,
wired (both power and DyNet) according to the
corresponding installation instruction and powered
ON.

Sensors and user interfaces are installed and

wired according to the corresponding installation
instructions.

Basic checks have been performed to make sure the
controllers are wired correctly.

A PD-PCN PC node is available.

The recommended version of System Builder is
installed on the PC of the commissioning engineer,
and the Technical license is enabled.

@ Important

For the recommended version of System Builder, see
the System Release Notes.

The latest firmware of the Site Gateway is
downloaded from the Signify Partner Portal.

For projects configured for wireless: The Site Enabler
app is installed on the phone of the commissioning
engineer. See section 4.4.3 Install Philips Dynalite Site
Enabler app.
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I insert Devices from Network - Connected - Philips Dynalite System Builder

Discovered Devices Search Devices

O

X

Select / Deselect All Add Devices Add and Load Devices | & Discover Network + Retest | ffl Change Box Numbers (i Update Box Numbers
Device Type Conflict Box Number New Box Number Serial Time

[[] =m DDBC120-D... - | Ballast Controller (Loa... | Exists in Job 1 5771873 21/11/2022 14:42:39

[ [ paoPe | Antumbra (User Interf... | Exists in Job 83 40432883 | 21/11/2022 14:42:58

[] /== | PDDEG-S v | Gateway - Ethemet (.. | Existsin Job 10 5470210 21/11/2022 14:43:10

Save Data To Device

Do you want to save device data to the 3 selected
devices?

Save Options
(O) Save modfied device data (Shift+F12)

(® Resave all device data
{this is only required for devices modified extemally)

| OK || Cancel

[] Save entire memory

< Main contents & Chapter contents

5.2 Wired commissioning

@ Important
e Seeappendix A3 - Configure DALI individual
addressing how to configure DALI individual
addressing.
e See appendix A4 - Configure DMX for RGB
lighting how to configure DMX for RGB lighting.

5.2.1 Discover devices

1. Open thejob file of the project that you prepared
during the offsite preparation.

2. Connect the PCto the DyNet using a USB PC Node
(PD-PCN).

3. Use thesign-on button on each device to discover all
devices.
Or: On the Insert menu, click Devices from Network.
Click Discover Network and assign the discovered
devices to the project.

4. Press Shift to multiselect all devices and press F12.
Select Resave all device data and click OK.
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Device Firmware Upgrade

Do you want to change the fiware for the following 1 device(s)?

Fa¥
£ l i

[ &= ==

Device FW Version Details

3

~,ﬁlﬁ)DE!(I‘I2()4:)%.\ [DC:0x65 (DALIMM2), BN:1] 2171->218 Minor firmware upgrade

<

Firmware File Summary:

File name: C:\Users\621370552\Downloads\DDBC120_DALI_V4_2v18b2 uu
Type: DALIMM2
Firmware version: 2.18

Select File... OK

Cancel

5.2.2 Upgrade firmware

@ Important
Don’t upgrade the Ethernet Gateway, this will be
done later during the commissioning process.

1. Inthe System view, select the devices in the list one
by one.

2. Right-click the device and select Firmware Upgrade.

3. Select the previously downloaded and extracted uu-
file that corresponds to the device (see section 4.4.2
Prepare commissioning). Click OK.

4. Wait until the process is finished.

5. Right-click the device, click Save To Device and select
Save modified device data. Click OK.

=) Note
The firmware upgrade procedure can take up to 30
minutes per device.
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5.2.3 Configure the Ethernet Gateway

Realtime Clock n
et Devvee Time Set location and time zone
13:21:10 Standard Time
The Ethernet Gateway needs to run on the correct time

and location information.

Time:
Date Sunday, 20 November 2022

Device Daylight Saving

DLS Start: Last Sunday of March at 02:00 +60mins
DLS Stop: Last Sunday of October at 03:00 . . .

e S 1. Inthe System view, right-click the Ethernet Gateway
Survise Today: | 080600 and select Network Actions > Set Realtime Clock.
Sunset Today: 17:54:00 . . . . .

2. Select the option Synchronize with PC Time. Click

Set Device Time
(® Synchronise with PC Time Apply a nd Close.

9 PC Tins: | 1950 3. Again, right-click the Ethernet Gateway and select
PC Date: |lunes. 21 noviembre 2022

Configure > Set Location and Timezone.
4. Select the correct Country and City.

(O Manually Set Device Time

19:21:07

il Or:select the Time Zone that corresponds with the
Foply | [ Close site location.
ﬂ System Builder - Set Device Location And Time Zone e ped
Location B Note
. - You can also set or change the location and time zone
DMS Lattuce DMS Longi.de with the Store Control Ul.
Time Zone

Time Zone {UTC+01:00) Amsterdam, Berin, Bem, Rome, Stockhaolm, Vienna

Last Sunday March 02:00:00 =
Last Sunday October 03:00:00 &
Set as Defautt Cancel
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User Properties

Name

Password

Enable

General Permissions
FTP

Telnet

Web server

Web Socket / Cloud Connection
Web Server Permissions
Web pages (HTTP GET)

File upload (HTTP POST)
CaGl

Feature Permissions
User management read

User management write
Certificate read

Certificate write

Store Manager
SRR RRRRRRRRRRRRRRRRRRRRRY

True

Enabled
Enabled
Enabled
Enabled

Enabled
Enabled
Enabled

Enabled
Enabled
Enabled
Enabled

Add users

To create access to the login screen of the Store Control
Ul, there are two users defined with different access
rights.

Add Store Manager

1. Inthe System view, select the Ethernet Gateway.

2. Select the tab Users.

3. Select the user Store Manager and create a password
for this user. Confirm the password.

@ Important

e Create a password consisting of capital and
lowercase letters, numbers and special characters
with a minimum length of 10 characters, for
example Vu@95dGk!0

e Make sure that you remember the password and
store it at a safe place. You need it to login to
the Ul.
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blber Properties

Name Store Staff
Password GOEBBRABRRRBRBBRRBRRRERIAS
Enable True

- General Permissions
FTP Enabled
Telnet Enabled
Web server Enabled
Web Socket / Cloud Connection Enabled

- Web Server Permissions
Web pages (HTTP GET) Enabled
File upload (HTTP POST) Enabled
Cal Enabled

-/ Feature Permissions
User management read Enabled
User management write Disabled )
Certificate read Enabled
Certificate write Enabled

& Main contents

& Chapter contents

< 5.2 Prepare commissioning

Add Store Staff

1.
2.
3.

In the System view, select the Ethernet Gateway.
Select the tab Users.

Select the user Store Staff and create a password for
this user. Confirm the password.

Important

e Create a password consisting of capital and
lowercase letters, numbers and special characters
with a minimum length of 10 characters, for
example Xa%83HKn?4

e Make sure that you remember the password and
store it at a safe place. You need it to login to the
Ul.

Check if the setting User Management Write is set to
Disabled.
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Connect to the Wireless Access Point

Q Gateway Wizard (PDDEG-S #10) - Step 1 of 4 = O X
Select Application T
Choose an Bheme:p:5~455 or Ethemet/Ethemet application for your gateway {j\ @ NOte
e When using the PDTS, you can skip this procedure,
Sy Sebecion Syt Dol but make sure to fill in all details in the Device
o ot e Properties tab.
(O Ethemet to RS-485 Translation Gateway . . . .
) b et et ey ¢ Inthis document, the Wireless Access Point is
) Eremette PuB liast Goteny configured with the IP address 192.168.1.50.
() Hotel Floor Ethemet Gateway
Cotiuraion Seecton Qahm S 1. Inthe System view, right-click the Ethernet Gateway
St S S and select Bridge Configuration Wizard.
[192768 1 50 | 0.0 0 0| .
o Subaetmadk DNS server 2. Select DyNet Ethernet Access Point and complete the
d  EErrms eeoeens following settings before you click Next:
Web Server i)
OHTTP @ HTTPS a. Select the Connections checkbox.

b. Select the Static IPv4 Address checkbox.
c. Enterthe agreed IP address, in this example
192.168.1.50.
d. Enterthe router subnet mask, for example
255.255.255.0.
e. Select the Web Server checkbox and select HTTPS.
3. Click Next and Finish to close the wizard.

Next > Cancel

@ Tip
In case the HTTPS option is not available, clear the Web
Server checkbox and select it again.
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Create Device Schedules Bridge Address Ranges Pots  Routing Hue Bridges Rhythm Send Metrics Users  Switches Area Casci * | * configure Metrics

& New X Delete |53 Copy [, Paste o5 4] ‘

Enable  Metric Type Description
Device Online Status Method: ..

e Metrics enable the device status feedback in the Store
m::stype :E::tl:eedomlne Status Control UI_

Method Poling
Comm Port
Protocol DyNet2

Poling terval 00:00.20 1. Inthe System view, select the Ethernet Gateway.
2. Select the tab Metrics.
3. Click New and complete the following settings:

e Porttype: Comm Port
e Pollinginterval:  00:00:30
Port type 4. Right-click the device, click Save To Device and select

Selects the port type over which the data is collected.

Save modified device data. Click OK.

< Main contents <& Chapter contents < 5.2 Prepare commissioning
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System View o x

R (ll-4 3

g # ﬂ ]0
= Network Devices

=- € e=m A[B] [J POOEGS #10
- [M Load Controllers
[+ s B DDBC120-DALI
=-[Z] User Interfaces
EH PADPE #83 (Back of house)

Connection Settings

(O Use machine connection settings

Connection Type Ethemet trunk connection

Configure | Status | Connected
Connection count 1
(O Use job specific connection settings
Configure....

Use Ethemet Trunk Connection

\TCP Only v

d Connected - 1/ 1 TCP Connection (Trunk, Automatic)

< Main contents <& Chapter contents < 5.2 Prepare commissioning

Configure connection settings

1. Inthe System view, select the project name given to
the job file.

2. Select the tab Connection Settings.

3. Select Use Ethernet Trunk Connection and click Yes
to reconnect.

4. Check the connection status in the lower-right
corner.

5. Save the job file.
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Check the firmware version of the Ethernet Gateway

1.

Check the firmware version of the Ethernet Gateway
with the recommended firmware version on the
MyLighting portal.

If necessary, load the correct firmware version
following the instructions that can be found on the
MyLighting portal.

5.3 Wireless commissioning

= Note
The procedures in this section are applicable for
projects that are configured for wireless and can also
be used for hybrid projects (consisting of wired and
wireless controllers)

5.3.1 Commission using the System Enabler app

@ Important
Always make sure to synchronize the data of the
commissioned project. Don't uninstall the app or
change the project as this will prevent synchronizing.

@ Tip
In case that there is no internet connection available
in the building, start the app outside of the building
and open the project, then go inside and commission
the project, and then synchronize the data outside of
the building.
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Setup internet connectivity

1. Login to the app and select the project.

2. Tap Establish connectivity. Select Use available
e S internet connection.

My project(s) : 3. The system checks the internet connection.

26 Feb 2024 4. Tap Done.

09:17 88% (@m)

No SIM & 88% (@m)

Wireless Hybrid Demo HTC48-A Connectivity Setup

26 Feb 2024

5480418
23 Feb 2024

HTC48 East - FLEX

20 Feb 2024

5470601

20 Feb 2024
Internet Connection
5480422

10 Feb 2024

Use available internet connection
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Add lights

1. Inthe app, tap Area commissioning.

2. Select an Area and a Channel to commission.
Sales Floor :

Areas ) @ Important

Don’t use the area called Unassigned Area for
commissioning.

Channels

Checkouts

” Add Lights
. OLights = Channel - Spots Caisses B
Fresh food NOte
o Lights Wireless networks In case the app asks permission to use Bluetooth, tap
Drinks o Allow.
0 Lights .
0 lights
Meat&Fish — 3. Tap Add lights.
0 Lights . . .
0 lights 4. Using the light plan, select the Wireless network to

Others
0 Lights

add the light to. Tap Select.
The app uses Bluetooth to scan for lights nearby. A
list with lights that are found shows.

Test the area to mark it as completed

= Note
Each wireless network corresponds with a Wireless
Gateway.
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5. Tapthe luminaire icon to blink the light. This helps
with identification of the lights.

Add Lights (=) Note
Channel - Spots Caisses Write down on the light plan the id that belongs to
the specific light.

© Adding to w01

S8 Reit o 7. Repeat forall lights in the channel. Tap Done if all
Philips SM515T ESE3 Iights are added to the channel.
] Phi|ip5 TCMSMT 305E

Philips TCMSMT 30CC

A Philips TCMSMT 2E27

© | cannot find all lights

Test channel

< Main contents < Chapter contents < 5.3 Configure the Ethernet Gateway

6. If the blinked light belongs to the channel, tap Add.
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Can't find all lights

* Powercycle the lights.

Make sure that Bluetooth and location services

are activated on your device.

e Stand close to the lights.

I still cannot find all lights

< Main contents < Chapter contents < 5.3 Configure the Ethernet Gateway

Reset lights

=) Note

Sometimes lights may already be assigned to a
wireless network. In this case a reset of the lights is
necessary.

In case not all lights can be found, tap | cannot find

all lights.

Follow the explanation and tap Retry.
If the problem persists, tap | cannot find all lights and
then I still cannot find all lights.

. Tap the luminaire icon to blink the light. When you

find a light that belongs to the channel that you are
editing, tap Reset.

. Add the light to the channel following the previous

procedure.
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Test channel
1. After finishing adding lights to a channel, tap Test
channel.

2. Tap the button ON/OFF to turn on or off the lights.
Check if the lights corresponding to the channel
respond as expected.

X Test channel

Turn the light on/off to test if all the

right lights are assigned.

=) Note
e |ttakes some time before the button becomes
responsive.

e The button shows the state of the lights in the
channel: Red is ON, grey is OFF.

3. When ready, tap Done.
4. Proceed with a next channel to add lights to.

< Main contents < Chapter contents < 5.3 Configure the Ethernet Gateway 82
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Test Area
1. After finishing all channels, select the area.
No SIM = 09:24 88% @m) 2. Tap Test area.
¢ Choosethe status 3. Tap the button ON/OFF to turn on or off the lights.
Area status Check if the lights corresponding to the channel
respond as expected.
Not set 09:25 88% @m)
O Completed Add a note (optional) v = Note
T— e Ittakes some time before the button becomes
responsive.
S S e The button shows the state of the lights in the
Ready to witness channel: Red is ON, grey is OFF.

4. When ready, tap Next. Select the status of the area.
5. Optionally, it's possible to add a note the status of the
area.

Done

Add note (optional) and wireless networks.

Repeat the procedure in this section for the other areas
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) Interact Accounts >

ud Add - Delete

Current active account Log out
® [ynalite Cloud
(Global)

& [Oynalite Cloud
me@dealer.com

(Global)

Close

. Dynalite Cloud Online - me@signify.com, Global

5.3.2 Retrieve job file

Login to the cloud

1. Connect the PCto the internet and run the
recommended version of System Builder.

2. Onthe Tools menu, click Interact Accounts. Check if
you are logged into Dynalite Cloud.

= Note
e Your user account must be registered before you
can login to your Interact Account. See section
4.3.5 Save job file to the cloud (wireless only)
e The status bar at the bottom shows your
connection status and the region you're
connected to.
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Select Dynalite Online Job File

QOrganization

|I'uh.' Projects

Job Files

e B

Name Description Last Modified
21-2-2024 10:58.44

Open Previous Revisions...

Mame 4
= 2% |@| Untitledlob2
= [  Metwork Devices
BB >3] ] » | PoDEGS |
=[] WNetwork Devices
#¥ =] o= PDZGEDL
’1" =| Qe PDIGED2

< Main contents < Chapter contents < 5.3 Configure the Ethernet Gateway

Open

Cancel

Download job file

1.

w

On the File menu, click Open and select Open Job
From Cloud.

If applicable, select the Organization.

Select the name of the job file to open. Click Open.
Check if a green padlock shows next to the project
name.
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ﬂ Insert Devices from Metwork - Connecting - Philips Dynalite System Builder

Discovered Devices  Search Devices

Device Type Conflict Box

Select / Deselect All Add Devices Add and Load Devices Ck Discover Network -

Discover Devices over R5-485

Discover Devices over Ethernet

5.3.3 Discover devices

= Note
Make sure to connect the PC to the DyNet using a

USB PC node.

General

1. Use the sign-on button on each device to discover all
devices.
Or: On the Insert menu, click Devices from Network.
Click Discover Network and assign the discovered
devices to the project.

2. Press Shift to multiselect all devices and press F12.
Select Resave all device data and click OK.
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5.3.4 Upgrade firmware

Device Firmware Upgrade n
A Do you want to change the fimware for the following 1 device(s)? 1. Inthe SyStem view, select the devices in the list one
PN by one.
e ——— "TrY 2. Right-click the .deV|ce and select Firmware Upgrade.
@) DDBC120-DALI [DC-0x65 (DALIMMZ), BN-1]  2.17.1 5 218 Minor firware upgrade 3. Select the previously downloaded and extracted uu
file that corresponds to the device (see section
4.4.2 Prepare commissioning). Click OK.
4. Wait until the process is finished.
< >
_ _ 5. Right-click the device, click Save To Device and select
Fimware File Summary: . . .
[Fie name- C-\Users\621370552\Downloads\DDBC120_DALI_V4_2v1852 uu Save modified device data. Click OK.

Type: DALIMM2
Firmware version: 2.18

= Note
The firmware upgrade procedure can take up to 30
minutes per device.

Select File... OK Cancel

6. On the File menu, click Save As and select Save Job
To Cloud to keep the job file updated.

= Note
e Checkif any luminaire that has been added using
the Enabler app appears under its associated
PDZG-E Wireless Gateway.
e No luminaires added yet? Then proceed with
securing the Ethernet devices. See section
5.3.5 Secure the Ethernet devices.
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& Philips Dynalite System Builder - Certificate Manager X

Select Certificate Type
Configure Web Server Certificate:
() System Builder Certificate
Configure Other Device Certificates:
e (® Device Site Cetificate for TLS Connections

(O Self-signed Certificate (O Certficate Authority (CA) certificate

(O 802.1x Certificate

Create and Upload Certificate
System Builder will use the Site Certificate configured for the job and the certificate signing request data from the
device to create a device specffic certificate that is then uploaded to the device. This is used by devices to
autherticate other devices and SB / SM that belong to the same specffic site when they connect to each other

B3P Create and Upload

Status: | Sign with cument Site CA for job:
Name: Dynalite Site CA - Store Flex examp
Thumbprint: D21448237CFABEF74918AAGD305AFD 2654407600

Epiy: | Monday . January 1.2085  [)v|

Systemn View
43 -2A0 FRFPBSOHINOD
Hame Address

= L)@ Secured Connection Test
S (B Metwork Devices
J-f@ POOEGS #53 JS3 |

I — M twigrk Devices

3 =(@)o~ weo1
e Luminaires
) Phiips ST2I0T 0xD758
e = X :j WG02 2

=3 Luminaires
| Phiips luminaire 0xEB3C
& Phiips luminare 0xES33

< Main contents < Chapter contents < 5.3 Configure the Ethernet Gateway

5.3.5 Secure the Ethernet devices

Create a site certificate:

1. From the Tools menu, select Set Site CA Certificate
and click the Create button.

2. Click the Yes button to export the certificate and add
a password.

3. Save the file to your PC and the click the Close button.

Apply security certificates

1. Inthe System view, right-click the PDDEG-S and
select Gateway Actions > Manage Certificate.

2. In Select Certificate Type, select Device Site Certificate

for TLS Connections.

Click Create and Upload and click Close.

Repeat also for all PDZG-E devices in the project.

Check if all devices now show a green padlock.

On the File menu, click Save As and select Save Job

To Cloud to keep the job file updated.

o v kW

88



05 Onsite commissioning

Change connection setting
1. Inthe System view, select the PDDEG-S.

Connection Settings
2. On the tab Connection Settings, under the option

L) Use machine connection seltings Use Ethernet Trunk Connection, select TCP TLC.
Configure 3. Onthe File menu, click Save As and select Save Job
() Use job specthic connection sefings To Cloud to keep the job file updated.
Confagure

&) Lse Ethemet Trunk Connection

TCP LS (Sacure Trunk 2 Q

=
) Use Senal Trunk Cornection
() Use Online Gatevway Connachion

Configune

< Main contents < Chapter contents < 5.3 Configure the Ethernet Gateway
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Propeties Connection Sefings  Ouiputs  Bridge Address Fanges FPorts  Fotng  Meirics AresCascadng Tasks Device Disgnostic  Product Detals
Routing 3¢ Delete Routing | 43 Copy (§% Paste [ Route RS5-425 and Default Multicast Service

Enable  From — = To Fiters

IPud Port 1, Trurk, TCP Chert. IP: 192.168.1 50 [Poet: 50443 [Secure - [ZgBee P 1, Spur g 1 e |
Metrca Cobection e v [1Pvs Port 1. Trunk., TCP Chent, IP- 192.168.1.50{ Port: 50423 Secure | Mo fiter
Intemal Messages w (IPwd Port 1. Trunk. TCP Chent. IP- 192 168 1,50 Powt: 50447 Secure v | No filker
DgBee Port 1, Spur s JiPwd Port 1, Trunk, TCP Cent, IP: 152 168.1.50| Port: 50443 Secure w | No fiker
] Add = € Delete | 4 Copy
Pt Tyoe, Index Cornection  Desscnption S
) 1Pd Post 1 D\.'Tlerlmz
% ZigBes Port 1 4.1 Spur ZrgBee endpont: 65515 ;9\2153 150
(3 o
TCP

Disabled

True

i Comm Por 1 1.1

] 1Pv4 Post 1 21 Trk TCP Server, Port: 51443, Secure
[ IPvd Port 2 2.2 Spur TCP Server, Poet- 50443, Secure
4 Web Socket 1/ Cloud Connection / BACnst 5.1 Trurik

€ >

< Main contents < Chapter contents < 5.3 Configure the Ethernet Gateway

Secure Ethernet connections

1. Inthe System view, select a PDZG-E.

2. On the tab Routing, make sure that the unsecured
port 50000 is replaced by the secured port 50443.

3. On the tab Ports, make sure to delete port 50000 to
avoid any unsecured connection.

4. Repeat for all PDZG-E Wireless Gateways in the
project.

5. Inthe System view, select a PDDEG-S.

6. On the tab Ports, make sure to delete all unsecure
ports:
e Port 50000
e PortuUDP

7. Repeat for all PDDEG-S Ethernet Gateways in the
project (if any).

8. Press Shift to multiselect all devices and press F12.
Select Resave all device data and click OK.

9. Onthe File menu, click Save As and select Save Job
To Cloud to keep the job file updated.
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5.3.6 Configure the Ethernet Gateway

Realtime Clock n
I Set location and time zone
19:21:10 Standard Time
The Ethernet Gateway requires to run on the correct
time and location information.

Time:
Date Sunday, 20 November 2022

Device Daylight Saving

DLS Start: Last Sunday of March at 02:00 +60mins
DLS Stop: Last Sunday of October at 03:00 . . .

e S 1. Inthe System view, right-click the Ethernet Gateway
Survise Today: | 080600 and select Network Actions > Set Realtime Clock.
Sunset Today: 17:54:00 . . . . .

2. Select the option Synchronize with PC Time. Click

Set Device Time
(® Synchronise with PC Time Apply a nd Close.

9 PC Tins: | 1950 3. Again, right-click the Ethernet Gateway and select
PC Date: |lunes. 21 noviembre 2022

Configure > Set Location and Timezone.
4. Select the correct Country and City.

(O Manually Set Device Time

19:21:07

il Or:select the Time Zone that corresponds with the
Foply | [ Close site location.
ﬂ System Builder - Set Device Location And Time Zone e ped
Location B Note
. - You can also set or change the location and time zone
DMS Lattuce DMS Longi.de with the Store Control Ul.
Time Zone

Time Zone {UTC+01:00) Amsterdam, Berin, Bem, Rome, Stockhaolm, Vienna

Last Sunday March 02:00:00 =
Last Sunday October 03:00:00 &
Set as Defautt Cancel
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User Properties

Name

Password

Enable

General Permissions
FTP

Telnet

Web server

Web Socket / Cloud Connection
Web Server Permissions
Web pages (HTTP GET)

File upload (HTTP POST)
CaGl

Feature Permissions
User management read

User management write
Certificate read

Certificate write

Store Manager
SRR RRRRRRRRRRRRRRRRRRRRRY

True

Enabled
Enabled
Enabled
Enabled

Enabled
Enabled
Enabled

Enabled
Enabled
Enabled
Enabled

Add users

To create access to the login screen of the Store Control
Ul, there are two users defined with different access
rights.

Add Store Manager

1. Inthe System view, select the Ethernet Gateway.

2. Select the tab Users.

3. Select the user Store Manager and create a password
for this user. Confirm the password.

@ Important

e Create a password consisting of capital and
lowercase letters, numbers and special characters
with a minimum length of 10 characters, for
example Vu@95dGk!0

e Make sure that you remember the password and
store it at a safe place. You need it to login to
the Ul.
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blber Properties

Name Store Staff
Password GOEBBRABRRRBRBBRRBRRRERIAS
Enable True

- General Permissions
FTP Enabled
Telnet Enabled
Web server Enabled
Web Socket / Cloud Connection Enabled

- Web Server Permissions
Web pages (HTTP GET) Enabled
File upload (HTTP POST) Enabled
Cal Enabled

-/ Feature Permissions
User management read Enabled
User management write Disabled )
Certificate read Enabled
Certificate write Enabled

& Main contents

& Chapter contents

< 5.3 Configure the Ethernet Gateway

Add Store Staff

1.
2.
3.

In the System view, select the Ethernet Gateway.
Select the tab Users.

Select the user Store Staff and create a password for
this user. Confirm the password.

Important

e Create a password consisting of capital and
lowercase letters, numbers and special characters
with a minimum length of 10 characters, for
example Xa%83HKn?4

e Make sure that you remember the password and
store it at a safe place. You need it to login to the
Ul.

Check if the setting User Management Write is set to
Disabled.
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Configure Metrics

Create Device Schedules Bridge Address Ranges Funf Routing Hue Bridges Rhythm Send Metrics Users Switches Area Casci | * MetrICS ena ble -the dEVICe StatUS feed back in -the Store
& New X Delete |53 Copy [, Paste o5 4] ‘
Enable  Metric Type Description ContrOI UI
Device Online Status Method: .. Metric type | Device Online Status
Metric | Enabled
Method Poling .
: E’:mm;on 1. Inthe System view, select the Ethernet Gateway.
rotocol Net.
Poling nerva 00:00:30 2. Select the tab Metrics.
3. Click New and complete the following settings:
e Porttype: Comm Port
e Pollinginterval:  00:00:30
4. Right-click the device, click Save To Device and select
Port type , , Save modified device data. Click OK.
Selects the port type over which the data is collected.

< Main contents < Chapter contents < 5.3 Configure the Ethernet Gateway
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System View
R (ll-4 3

= /0

[

= Network Devices
=- € e=m A[B] [J POOEGS #10
- [M Load Controllers
[+ s B DDBC120-DALI
=-[Z] User Interfaces

EH PADPE #83 (Back of house)

Connection Settings

Configure...

Configure....

(O Use machine connection settings

Connection Type
| Status

Connection count

(O Use job specific connection settings

Use Ethemet Trunk Connection
\TCP Only

Ethemet trunk connection

| Connected
1

ﬁ Connected - 1/ 1 TCP Connection (Trunk, Automatic)

& Main contents

& Chapter contents

e

5.3 Configure the Ethernet Gateway

Configure connection settings

1. Inthe System view, select the project name given to
the job file.

2. Select the tab Connection Settings.

3. Select Use Ethernet Trunk Connection and click Yes
to reconnect.

4. Check the connection status in the lower-right
corner.

5. Save the job file.
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5.3.7 Verify the wireless system
After completing all steps, including adding the wireless
luminaires, you can proceed with system verification:

1. Inthe System view, select a PDZG-E.
2. On the tab Device Diagnostics, check if all added
luminaires apprear.

= Note
Loading this tab may take several minutes.

3. Check for each luminaire if the scenes (maximum of
64) are synchronized.

4. Send Preset messages to the luminaires and check if
everything is working accordingly.

5. Repeat for all PDZG-E Wireless Gateways in the
project.
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5.4 Install and configure the Store Control Ul

interact X

e i 5.4.1 Download the Store Control Ul

General
Downloads + PDEG firmware image

« PDEG product image

e + PDEG web-Ul

1. Login to the Signify MyLighting portal.

n 'Tq:et?echmcalnDdte;n‘enrﬂfulnsto L:ﬂzlp\he ﬁlePDEG}JCF(ARJ‘»’GW;HlenLProduc”I.AojgaRC,\g BE ‘ 2. On the DaSh boa rd, CI iCk HTM L teChnicaI dOCU ments

(635).zip. Instead of this file, read: PDEG_CFIAR_WebContent_Production_iaRC_v1-7-1-(715b).zip. a nd open the pages for Store FIeX.

{ { 3. Download the package with the web-Ul that
"use24hourformat™: false, "use24hourformat”: false, corresponds Wlth the gatewaythat you configured.

"selectedFirstDayOfWeek": "7, "selectedFirstDayOfleek": "7",

% "outdoor™: nu11|, w"outdoor": 4,

"timeFormat": { "timeFormat™: {

"_24Hours” : "HH:imm", "_24Hours” : "HH:mm", 5.4.2 Configure the Outdoor Area
. " 12Hours™ : "hh:mm A" . " 12Hours™ : “hh:mm A"
Laterormat oy ML, Yo e it T 1. Inafile explorer, find the zip-file containing the web
' } Ul and unpack it.
2. Double-click the file and open config.jsn with
Notepad.
3. Change the parameter outdoor if necessary:
a. Outdoor area configured: 4

b. No outdoor area configured:  null
4. Save and close the file.

=) Note
The outdoor area is by default configured as Area 4.
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5.4.3 Load the Store Control Ul

Option

g Please select an option to upload web pages
| |

() Select a zip file containing web pages
(®) Select a folder containing web pages

X 1. Inthe System view, right-click the Ethernet Gateway
and select Upload Custom Web Pages.

2. Click Select a folder containing web pages and click
OK.

3. Find the folder containing the web-Ul files.

4. Select the Delete existing pages checkbox and click

Cancel CIose
Device Web Page Upload u B Note
) e o e The upload of the web-Ui files takes up to a few
& |PDDEG-S #10 192.168.1.50 Complete .
minutes.

Web Page Uploading Summary:

Succeeded: 1

4

Folder: C:\Users\621370552\Downloads\|ARStore v1.65\dist

Completed 1 out of 1 devices

Delete existing web pages

< Main contents & Chapter contents <

5.4 Install and configure the Store Control Ul
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EJ untitledsob2 (CA..Drive - S
File Edit View Wind
NEHE; * G

System View

E23l-20 I

Name

= #d Unttedlob2
= [ MNetwork Devices
= ¥en @uﬁ
= [#] LoadCon
[+ -=mm DDBQ
B[] User Inte

R Paor

<

@ Areas P8 System | [ Buil

Command Monitor
Cancel

Cancel All | §

ID Name

T

&
Z
E
Y

X

™
=

-~
Load From Device...

Save To Device...

Connect
Disconnect
New Device

Insert Devices from Network...

Cut
Copy
Paste
Delete

Rename
Find Device Icon

Run Device Report...

Factory Set...

Firmware Upgrade...

Edit Memory...

Edit Tasks and Events...

Bridge Configuration Wizard...
Set Realtime Clock...

Set Location and Timezone...
Change Box Number...
Register Online Gateway...

| T0A.dIj) - Connected - Philips Dynalite S
nguage Help
HS- # X% 0@

o x
o W W |

Firmware Vers... IP Address

1.19.0 IPv4: 192.168.1.50, IPv!

2.18.2

3.16.0

[lands Show Simple Commands

Upload Cenfiguration

<

54 Application Log | Netw
PDDEG-S #10 - Status: Online

FTORE@E e rEEORE &

Download Logical Configuration
Upload Custom Web Pages...
Manage Log Files...

Apply OAuth Configuration

Manage Certificate...
v

Upload Logical Configuration
Upload Device List
Upload Job Properties

Upload All

(1 N

& Main contents

& Chapter contents

e

5.4.4 Load configuration
Loading the configuration to the Ethernet Gateway links
the logical configuration with the device list.

1. Inthe System view, right-click the Ethernet Gateway,
click Upload Configuration and select Upload All.

2. Wait until the message Successfully uploaded all XML
files appears. Click Accept.

5.4 Install and configure the Store Control Ul
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o

Select Certificate Type
Configure Web Server Certificate:
9 (@ System Builder Cedificate
onfigure Other Device Certificates:
(O Device Site Certfficate for TLS Connections

(O Selff-signed Certficate (O Certificate Authority (CA) certificate

(O 802.1x Certificate

Enter Details
To obtain a certificate first, enter the gateway details and location information.

9 Common Name (CN): 5192.1 68.1.50 City Or Location (L): ‘Madnd ‘

Organizational Unit (OU): |Dynalite State Or Province (S): ‘Madnd ‘

Organization (O): | Lighting Country (C) - 2 Characters: ‘ ES ‘

Create and Upload Certificate

System Builder will create and upload a certificate. The root certificate that System Builder uses to sign this
certificate can then be installed by saving to file and then right clicking and selecting ‘Install Certfficate’. It's important
to install the certificate into the Trusted Root Certification Authorities” store. This will allow the browser to show the
connection as trusted.

e Create and Upload

Status:

Expiry: | lunes . 1de enero de 2085 ‘

Altemative address or domain: |

Successfully uploaded and verified the certificate ‘

Save Root Certificate to File...

e -

< Main contents & Chapter contents

5.5

Create and install certificate

=) Note

e The procedures in this section are applicable for
installations with an Ethernet Gateway only.

e Inthis document, the Wireless Access Point is
configured with the IP address 192.168.1.50.

5.5.1 Create certificate

1.

In the System view, right-click the Ethernet Gateway
and select Gateway Actions > Manage Certificate.
In the section Select Certificate Type, select System
Builder certificate.

Enter the gateway details and location information.
Make sure to fill in the correct IP address at Common
Name (CN), in this example 792.168.1.50.

Click Create and Upload.

Wait two minutes for the system to create a signed
certificate on the gateway.

After successful upload of the certificate, a message
appears. Click Yes to proceed and click the Close
button.
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@ Privacy error X

A 192.168.1.50/signify.cer v

A

Your connection is not private

Attackers might be trying to steal your information from 192.168.1.50 (for example,
credit cards). Learn more

NET:ERR_CERT_AUTHORITY_INVALID

[ Help improve ng URLS of some pages that you visit, limited system

information ar

Hide advanced Back to safety

This server could not prove that it is 192.168.1.50; its security certificate is not trusted by

5.5.2 Install certificate

A certificate is required to enable a secure connection
between the operating device (for example a tablet) and
the gateway. When you use a device for the first time,
while accessing the user interface the warning message
Your connection is not private, or similar, shows up.

Download certificate

= Note
This instruction is written using a Chromium-based
browser, like Google Chrome.

1. Inthe web-browser, go to
https://192.168.1.50/Signify.cer.

2. If the message Your connection is not private appears,
click Advanced.

3. Click/Tap Proceed to 192.168.1.50 (unsafe).
The certificate is downloaded to the device.

= Note
When you have the option to Open the file, ignore
and close the message.


https://192.168.1.50/Signify.cer

05 Onsite commissioning

Settings

SnD Internal

Applo 10, Cloud, (Tunes & App 5L..

Apple 10 Suggestions [2]
Prafile Downloaded

Airplane Mode

General

Software Update

AirDrop
Handoft

Multitasking & Dock

Accessibility

iPad Storage

<& Main contents

Cancel

Install Profile Install

@ Signify Dynalite System Builder

Signed by Sigrify Dynoite Syatem Buiider
Mot Verified

Conalen CartifaGabs

Maore Details

Remove Downloaded Profile

& Chapter contents & 5.5 Create and install certificate

Install certificate on a device running iOS

=) Note
The steps in this section are intended for iOS 12.

In the device Settings, select Profile Downloaded.
Select Signify Dynalite System Builder. Tap Install.
A warning appears, tap Install.

A popup appears to confirm, tap Install.

Tap Done.

Clear the browser cache and close the web browser.

ouhkwnN-=
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< DOther security settings
MMake password s visible
Se:ur'n_\-_p alicy updates
Device admin apps

Credential storage

Storage type

Yiew securty certificates
User certificates

Install from device storage

Clear credentials

Name the certificate

Certificate name:
Signify

Credential use:
VPN and apps v

Mote: The issuer of this certificate may inspect all traffic to and from the device.

Cancel 0K

Install certificate on a device running Android

(=) Note

The steps in this section are intended for Android 9
to 13 and may be brand specific. Other versions of
Android may use slightly different steps.

In the device Settings, tap Security > Other security
settings.

Find Credential storage and tap Install from device
storage.

Select the file signify.cer and tap Done.

Enter your Screen Lock (for example a pattern or PIN-
code). Tap OK.

Note

When a Screen Lock is not defined, you are asked to
set one up. Without a Screen Lock, it's not possible
install the certificate.

Give the certificate the name Signify.
Under Used for, select VPN and apps. Tap OK.

. A message that the installation was successful

appears.
Clear the browser cache and close the web browser.
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wh Certificate x

General Detais Certification Path

3§, Certificate Information

This CA Root certificate is not trusted. To enable trust,
install this certificate in the Trusted Root Certification
Authorities store.

Issued to: Signify Dynalite System Builder

Issued by: Signify Dynalite System Builder

Valid from 22-08-13 to 09-09-86

Install Certificate... | | Issuer Statement

Select Certificate Store *

Select the certificate store you want to use.

| Personal A
S| Trusted Root Certification Authorities

| Enterprise Trust

*| Intermediate Certification Authorities

| Trusted Publishers
- 1 1Intristed Certifircates

[] show physical stores

Cancel

Install certificate on a PC running Windows

=) Note
The steps in this section are intended for
Windows 10.

1. Find the certificate in the file system.
2. Double-click the certificate to start installation.
Click Open.
3. Click Install Certificate.
4. Inthe Certificate Import Wizard:
e Select Current User. Click Next.
e Select Place all certificates in the following store.
Click Browse.
e Select Trusted Root Certification Authorities.
Click OK.
e Click Next, then click Finish.
5. ASecurity Warning appears. Click Yes.
6. A message that the import was successful appears.
Click OK.
7. Click OK to close the Certificate popup.
8. Clear the browser cache and close the web browser.
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5.5.3 Check secure connection of the Ul

1. Open the web-browser and go to
https://192.168.1.50/. Login to the system.

2. Check if the address-bar shows closed padlock.
You can click the padlock to see the details of the
connection and certificate.

https://192.168.1.50/#/login

Connection is secure

Your information (for example, passwords or credit card numbers) is private
when it is sent to this site. Details

Site settings

< Main contents & Chapter contents & 5.5 Create and install certificate 105
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1822 Thu 14 Nov

< (1 192.168.1.50

Calendar

Regular Week

Sun Mon Tue Wed Thu Fri Sat
Default Default Default Default Default Default Default

Exceptions ¢ November 2019 )

Default Default

4
Default Default Default Default Default Default Default

10 11 2 13 14

Default Default Default Default Default Default Default
. 18 9 20 2 22 23

Default Default Default Default Default Default Default

Default Default Default Default Default Default Default

5.6 Verification and handover

= Note
The User Guide for Store Control Ul shows the usage
of the Ul for both store staff and store managers. This
document is available at support.dynalite.com/

5.6.1 Verify the installation

The Store Control Ul supports

1. Check ifitis possible to login as:
e Store Manager
e Store Staff
Use the password configured during the offsite
commissioning. See 4.3.3 Configure the job file.

2. Create or edit scenes according to the customer
needs. Apply the scenes to regular day to avoid
triggering preset 1 at midnight.

3. Check the system status and make sure all zones are
operational.


http://support.dynalite.com/
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Language

Date and time

Location

Settings

English »v

11 June, 2021 | 08:37

Amsterdam, Netherlands

(UTC+01:00) W. europe standard time

Daylight saving enabled

Use 24-hour format
First day of the week

Schedule Disable

PHILIPS

dynalite

Store Control Ul

Release 1.7.8

Lighting control with Store Kitand |
Store Flex for medium and large
sized stores

< Main contents < Chapter contents < 5.6 Verification and handover

In the settings, configure according to customer
preferences:

¢ Language

e Hour format

e First day of the week

Make sure that Date and time and Location are
set correctly to be sure that the Astro clock works
accordingly.

Provide a copy of the latest User Guide to the
customer.

Using the user guide, train the customer on the usage
of the system.
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Language

Date and time

Location

Use 24-hour format

First day of the week

Schedule Disable

Settings

English v

11 June, 2021 | 08:37 >

Amsterdam, Netherlands

5.6.2 Setthe operation mode

The Store Flex system supports inputs from a Building

Management System (BMS). In case a BMS is used, it's

necessary to disable the Scheduling Mode in the Store
Control Ul.

1. Login to the Store Control Ul and open the Settings
page.

2. Find the Scheduling Disable option and toggle the
switch to disable.

With the schedules disabled, the system is intended to be
controller by a third party BMS.
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6.1 Technical support

: 6.1.1 Ticketing system (C4CS)

Personnel of Signify
T ——— Follow the Learning Path Systems Support ticketing in
e ——— C4CS. The Learning Path explains how to submit a

L vt s e S ticket. Markets and System Centers to create a Business
Support Request ticket (BSR) providing the necessary
g detail, including specified architecture and owner.

Personnel of Customer System Integrators (CSls)
1. Login to the Signify MyLighting portal.

©niy 0 2. Click on Technical support.

0 > Dashboard > Webform

3. Search the knowledge base for any information on

the subject you want help for.
‘] 4. If youdon'tfind relevant information, click Request
—_— I | Support at the bottom of the search result.
‘ 5. Fill in the webform adding all mandatory details
required to support you.
Drag and drop files from y mputer to this area to upload to upload a new document
=

& Main contents 109
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A1 Configure DALI individual addressing
A2 Configure DMX for RGB lighting
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A1 Configure DALI individual addressing

System View R X | Device Propetties DALI Network  Create Device 10\;'tPLﬁS: Presets Switches Rhythm Receive NeaCao
BEL-AE B E %A OE .| CchekNewBallast & Enumerate Ballasts 59 Query Ballast Types [ Query Ballast Status &7 Upds
Name Address | De | Number Name Area | Channel | Load (Watts) Power Category | DALI Address
§ ’—’% U::::::;’[J)iwces :ailaa: z 2 1 L’éhﬁ“; ; B NOte
= D # allast 3 2 ightin 7 .
I Do " s h Lo e Applicable for all DALI addressable controllers,
- ToAz [Battase 32 T )
: e v ® like the DDBC120-DALI and DDBC320-DALI.
5 Ballast 32 1 Lighting Qo . .. .
Balless 3y baties @ e First finish firmware upgrades of all controllers.
Ballast 3 1 1 Lighting k
Ballast 3 1 1 Léhtmg : nk
Ballast 41 1 Lighting @ Unk
S L Lot 1. Inthe System view, select a load controller.
Lighting L7
Ballast 4 ighting k .
- , ST S — 2. Select the Outputs tab and click Enumerate Ballasts.
) Areas |PH System | Building | <
Discovered luminaires receive a Number and a green
B# Localize Lamps - Multi Lamp Mode . H
' icon with the status Known.
E Default Floor 3. Select the Flash checkbox to flash each discovered
| physical channel to validate the location.

69/100 localized . .
Or: Right-click an area or floor plan and select

=N Localize lamps.

E :l 4. Assign the physical channel to the corresponding
logical channel on the floorplan.

| I | 5. Upload the logical configuration to the Ethernet
Gateway after making changes to it. Only then are
the changes reflected in the Store Control Ul. See
section 5.4.4 Load configuration.

Settings
Include Load Types

© Only unlocalized lamps () All except Curtain and Fan

() Alllamps {use to relocalize lamps) © Al except Cutain, Fan and Switched
Assign (O DALl and 0-10V Only

© Next available channel

(O Channel 1 always

T Swkch o Sngle Lamp Mode
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Device Factory Set

Do you want to factory set the device 'DDNG485-DMX-Tx #6'?

l 5\
Save factory reset data to the device now
Product Description
=W DDNG485 RS-485/DMX512 Gateway
DDNG485-DMX-Rx  Philips Dynalite DMX Receive Gateway

E: DDNG485-Somfy

= _DDONG485-DMX-Tx Philips Dynalite DMX Transmit Gateway

Philips Dynalite Somfy Gateway

OK

Cancel

A2 Configure DMX for RGB lighting

Store Flex supports the use of RGB lighting to enhance
the experience of the shopper in the store.

A2.1 Setup DDNGA485

1. Inthe System view, select the DDNG485.

2. Right-click the device and select Factory Set. Select
DDNG485-DMX-Tx and click OK. Wait until the
process is finished.

= Note
The factory reset procedure can take several minutes
per device.

3. Right-click the device and select Firmware Upgrade.
Select the extracted uu-file corresponding to the
device. Click OK. Wait until the process is finished.

4. Move the device under the Ethernet Gateway. Click
Yes to confirm.

5. Right-click the device and select Save To Device.
Select Save modified data and click OK.
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A2.2 Setup RGB lighting

Mame Mumber
= #H BRIy 1. Inthe Areas view, select the area where RGB lighting
‘ Unassigned Area Al o
@ Retail Area A7 is installed.
[6) Parking Lot A3 2. Click Insert New Channel three times. Rename the
B @_, Eack Office hannel
— channels.
e . Canteen
@ Canteen C3 0 Important

Three logical channels are required to control red,
green and blue. Make sure to give the channels the
exact same name.

Channel Properties  Physical Channels  Unassigned Devices

.__- 4] | Filter:
= Channel Properties
MNumber 1

= s 3. Select the Unassigned Devices tab. Expand the
= - Gateways tree and find the unassigned Physical
= Channel Load Not Set Channels. Drag Physical Channel 1 to the first created
e oy Logical Channel.
Lbl s e I 4. Select the first Logical Channel. Select the tab
= Channel Properties and find the parameter Type.
o= Select the type Red.
A 5. Repeat the previous steps for the second and third
gl channel. Select respectively the type Green and Blue.
e 6. Right-click the device and select Save To Device.
R Select Save modified data and click OK.
Cakynes 7. Upload the logical configuration to the Ethernet
DMX Gateway. See section 5.3.6 Load configuration.

Coded Mains

< Main contents <& Chapter contents < A2 Configure DMX for RGB lighting 113
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B1 Lighting network components
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B1 Lighting network components

PDDEG-S or PDEG Ethernet Gateway

The Philips Dynalite PDDEG-S provides gateway services
between Ethernet and DyNet devices, enabling secure
online access to the Philips lighting control system.

The gateway enables lighting control via the Store
Control Ul, access to the timeclock and schedule editor
functions. It provides bridging functionality between the
Ethernet backbone and the DyNet fieldbus devices.

@ Important
e The PDEG Ethernet Gateway is not compatible
when planning to upgrade to Architecture
FLX Multisite.
e Usage of BACnet, also a requires a PDDEG-S as
central store controller.

= Note
The PDEG Ethernet Gateway requires power from the
DyNet network or a DDNP1501 power supply.
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PDZG-E Wireless Gateway

The Philips Dynalite ZigBee Gateway Ethernetis a
wireless communication hub that connects wireless
nodes (luminaires or wireless group controllers) to
the Dynalite lighting control system via an Ethernet
connection to the PDDEG-S.
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PDTS Touchscreen

The PDTS offers intelligent control and direct access
to scheduling, scene editing, diagnostics and local
environmental sensing.

(=) Note
The PDTS Touchscreen requires power from a
DDNP1501 power supply.
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B2 Controllers

DDBC120-DALI 1-Universe DALI-2 Driver Controller
The Philips Dynalite DDBC120-DALI features a single
DALI output, allowing to control of up to 64 DALI
devices. It also features 1 x 20 A feed-through switched
circuits for DALI driver mains supply.

DDBC320-DALI 3-Universe DALI-2 Driver Controller
The Philips Dynalite DDBC320-DALI features three DALI
outputs, allowing control of up to 192 DALI devices. It
also features 3 x 20 A feed-through switched circuits for
DALI driver mains supply.
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B2 Controllers

DDBC1200 Signal dimmer controller

The Philips Dynalite DDBC1200 features 12 independent
output channels, each selectable to DALI Broadcast,
0-10V/1-10 V or DSI. The device can also be linked to

a separate relay module for control of 0-10 V/1-10V

drivers.

DDRC420FR Relay controller

The Philips Dynalite DDRC420FR provides control of any
type of switched load. This four-channel device supports
all types of switched loads up to 20 A inductive.
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B2 Controllers

DDRC1220FR-GL Relay controller
The Philips Dynalite DDRC1220FR-GL provides control of
any type of switched load. All types of switched loads up
to 20 A inductive are supported. The maximum load may
be limited by 500 A inrush rating.

DDMIDCS8 Dry contact connections

Dry contact connections allow installation in electrical
wall boxes for easy integration with third-party user
interfaces. With this option it is possible to integrate
BMS or security systems with the lighting system, by
receiving input from the external system and run a
special task according to the requirements. Multiple
DDMIDC8 devices can be used in the system to add more
dry- contact inputs required in a project.
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DDNG485 RS-485/DMX512 Gateway

The Philips Dynalite DDNG485 is a flexible network
communications bridge designed for RS-485 networks.
The two opto-isolated RS-485 ports enable the
DDNGA485 to implement a trunk and spur topology on
large project sites, with the bridge providing a high-
speed backbone opto-coupled to many lower speed
spurs.

SC100 IA Transceiver
The SC100 IA transceiver is the ideal solution to
wirelessly connect luminaires connected to a DALI
| Extender or Xitanium SR Bridge to the Zigbee network.
It uses a simple two-wire connection between
transceiver and the SR device (SR driver or SR bridge),
= thus eliminating the need for multiple components and
- auxiliary devices. The result is a cost effective and easy
design-in solution ideal for energy-savings.

\ N
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Xitanium SR Bridge

The Xitanium SR Bridge is used to control multiple
luminaires with one SR sensor or to make existing
luminaires sensor ready. The Bridge features all the
elements of the SR interface. The SR sensor is connected
to the Bridge via the SR interface while a group of

. luminaires can be controlled both via the Bridge DALI

r interface and the mains relay integrated in the Bridge.

- : DALI Extender

The DALI Extender extends the SR bus to the DALI bus
and enables multiple applications requiring connecting
SR devices to DALI drivers or DALI emergency drivers.
2 The DALI Extender provides supply to the SR bus and the
- DALI bus.

This device enables longer cost-effective trunking lines
with a lower number of sensors, and remote testing of
» \ S emergency luminaires.

The DALI Extender can be installed independently or be
built-in to luminaire.

= Note
Currently, emergency lighting is not supported.
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SUPPLY

PHILIPS = gg ® :%., C€

dynalite
DDNP1501 F’

Network Power Supply
SUPPLY.  100-277V~, 0.5Amax

OUTPUT: 15V 1.5A, SELV/Class 2 (UL)
0°Cto 50°C (32'F to 122'F)

Made in Australia
Signify. IBRS 10461. 5600V8. NL

& Chapter contents

INDICATOR

B3 Optional components

B3  Optional components

DUS360CR Multifunction sensor

The Philips Dynalite DUS360CR is a recess mountable
360 degrees multifunction sensor that combines motion
detection (PIR), infrared remote-control reception (IR)
and ambient light level detection (PE) into one device in
multiple applications.

DDNP1501 Network Power Supply

The Philips Dynalite DDNP1501isa 15VDC1.5A
regulated power supply designed to supplement the
DyNet network DC supply.
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